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Preface
This guide describes how to use the Transporter for Tidal Workload Automation (TWA).

Audience
This guide is for administrators who configure, monitor, and maintain the Transporter for Tidal Workload Automation, and 
who troubleshoot Transporter issues.

Related Documentation
For a list of all Tidal Workload Automation guides, see the Tidal Workload Automation Documentation Overview of your 
release on tidalautomation.com at:

http://docs.tidalautomation.com/

Note: We sometimes update the documentation after original publication. Therefore, you should also review the 
documentation on tidalautomation.com for any updates.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional information, see 
What’s New in Tidal Product Documentation at:

http://docs.tidalautomation.com/rss

Subscribe to What’s New in Tidal Product Documentation, which lists all new and revised Tidal technical documentation, 
as an RSS feed and deliver content directly to your desktop using a reader application. The RSS feeds are a free service.
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Document Change History
The table below provides the revision history for the Tidal Workload Automation Transporter User Guide.

Table 1

Version Number Issue Date Reason for Change

6.2 June 2014 Updates for 6.2 release.

6.2.1 (SP2) May 2015 Updated installation instructions, licensing requirement 
removed, naming, and cross references plus content validation 
and editorial improvements.

6.3 June 2016  Added new Export/Import chapter and functionality. See 
Using the Transporter Export/Import Utility.

 Rebranded Tidal Enterprise Scheduler (TES) to Cisco 
Workload Automation (CWA).

6.3.1 May 2017  Added Importing/Exporting the Cron Jobs chapter.

 Added information about exclusion of certain files using the 
selection file, and exclusion of certain fields during the 
comparison process. For more information, see Using the 
Export/Import Transporter Interface section.

6.3.2 Oct 2017  Added transporter configuration for Kerberos 
authentication.

 Added Kerberos connection definition.

 Added Kerberos properties

6.3.3 Jan 2018 Re-branded “Cisco Workload Automation (CWA)” to “Tidal 
Workload Automation (TWA)”.
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1
Introducing the Tidal Workload Automation 
Transporter

This chapter provides an overview of the Tidal Workload Automation (TWA) Transporter and the basic steps of using the 
TWA Transporter.

Overview
The TWA Transporter application copies scheduling objects from one database (source) to another database 
(destination). The primary strength of the TWA Transporter is its ability to automate the transporting of job data, although 
it can transport other data types as well. The following discussion refers to the job transports.

Each database is designed with its own unique needs and purposes. While job data in each database may be comprised 
of many of the same objects, each also uses different objects in defining jobs, such as calendar, variable, agent, and so 
on. Ideally, the databases would use the same objects to define a job so a one-to-one relationship will exist between 
the job data in the two databases. Unfortunately, this one-to-one relationship rarely exists in the real world. For example, 
a test environment may refer to a different set of agents than the production environment. Using mapping rules, the TWA 
Transporter automates the process of promoting jobs from development to test or production databases.
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The Transporter compares the various objects of one database against the other database. Differences between the 
databases are noted and a job rule object from the source database can be matched to a different object in the 
destination database. When transporting job rules to another database, the TWA Transporter provides a list of possible 
values in the destination database that can be selected to make a match for the source object without a mate. By 
mapping objects from the source database to objects in the destination database, subsequent job rules using the same 
objects can be transported without manual interaction.

While the TWA Transporter is primarily designed to promote jobs between databases, it can also be used for 
synchronizing actions, events, variables, calendars, business views, resources, and job classes between two databases. 
An interactive mode and a batch mode are available for job transports.

The TWA Transporter has menu options and a toolbar to provide a convenient and easy-to-use interface to enhance the 
object transporting process between two databases. The multi-step process is simplified by the toolbar mirroring the 
sequence of steps that comprise the object rule transporting procedure.

TWA Export/Import Utility
The TWA Transporter also provides an export/import utility to migrate TWA objects like jobs, job groups, and calendars 
from one TWA system to another without requiring that both systems are running. Objects are exported and imported as 
files which can then be managed in your source control system. You can export/import individual jobs or job groups, or 
use the Transporter to save multiple job, group, or calendar selections to a file and export/import multiple objects in one 
operation. Using the job selections file also enables export of mappings.

The export/import feature can also create a delta set of objects that have changed between one export and another. This 
enables an incremental export/import which can save time and disk space. You can use a compare command to see the 
differences between exported files and the import destination.

Two interfaces are available to control the object export and import: the command line interface and the Transporter 
graphical user interface. You can use these two interfaces interchangeably.

After export and import, a validate feature can be used to ensure that all objects were successfully exported or imported.

See Using the Transporter Export/Import Utility, page 61 for details about the Export/Import utility.

Basic Steps of the Transporting Process
Transporting objects from one source to another requires transporting and/or mapping different types of data objects 
referenced by the objects as much as transporting the objects themselves. The process of transporting object data 
between a designated source and destination consists of the following steps, though not all of the steps may be 
necessary each time:

1. Create connection definitions – Define and save connections to the source and destination instances.

2. Connect the selected source and destination – Select a source to transport the object information from and a 
destination to transport the information to.

3. Read the data – After connecting to the source and destination, click the Read Data button. This happens 
automatically if the configuration option is set to do so.

4. For Jobs/Groups only, filter out unwanted job data – The list of jobs and job groups can be very extensive and 
difficult to work with without filtering the displayed list. While optional, it is recommended to use filtering to reduce 
the amount of job data displayed from the source. Jobs can be filtered by various criteria or wildcards using the Filter 
dialog.

Use Server Filtering for large scale databases to limit the number of records returned to the Transporter and improve 
performance. Select Include Dependencies when using Server Filtering to ensure the set of jobs returned also 
includes its dependent jobs. 
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5. On each data type tab, select the data objects to transport – Select the source objects to be transported. Search 
for specific source objects via the search text box and the Find and Next buttons.

6. Map the data to resolve differences between data objects – Map the data objects in the source with 
corresponding destination objects so that objects are correctly transported from the source to the destination. Use 
the Mappings dialog opened with the Mappings button.

7. Transport the data objects – Use the Start Transfer button to initiate the transport. Job transports have an 
interactive transporting mode where existing differences between source and destination jobs can be resolved on 
the fly. The interactive mode does not exist for other object transport types. 

The rest of this guide describes how to install and configure the Transporter and then perform each of these tasks.

Note: The Transporter Export/Import utility process is different than that process described above. See Using the 
Transporter Export/Import Utility, page 61 for how to use this utility.
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2
Installing the Transporter

This chapter describes how to install the Transporter in these sections:

 Minimum System Requirements, page 13

 Prerequisites, page 13

 Installing the Transporter, page 13

 Uninstalling the Transporter, page 14

Minimum System Requirements
The Tidal Workload Automation (TWA) Transporter can be installed on a machine running TWA, but it does not require it. 

For the system and software minimum requirements for running the Transporter, see your Tidal Workload Automation 
Installation Guide.

Prerequisites
Before installing and using the TWA Transporter, the following requirements need to be fulfilled:

 Before transporting ERP jobs (such as PeopleSoft, SAP, and Oracle Applications) ensure that the destination ERP 
system/agent meets the requirements to run the transported jobs.

For example, if running Oracle Applications jobs, verify that the same user responsibility used in the source ERP 
system/agent is available in the destination ERP system/agent. Also the same concurrent program or result set 
referenced in the source ERP system/agent must also be available in the destination ERP system/agent. In general, 
it is recommended that the ERP system/agent environment in the destination ERP system/agent mirror the 
environment in source ERP system/agent by using the same release version and the same system configuration.

 TWA 78-xxxxx-xx xx.2

 64-bit OS.

 For large-scale databases: Dual Core, 12 GB Ram (16 GB recommended).

 Both the source and destination machines must have the Client Manager installed. The Transporter accesses the 
Client Manager database. The Java Client is optional.

Installing the Transporter
The Transporter can be installed on any machine that has access to the source and target machines where the Master 
and Client Manager are installed. If you are installing the Transporter on a machine that does not already have TWA 
components installed, an extra step is required to specify where to install the Transporter. If TWA components exists on 
the machine, the installation program installs the Transporter into the existing TIDAL directory (by default, TWA 
components are installed in the C:\Program Files\TIDAL directory).
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The Transporter software is bundled with the Tidal Workload Automation Base Product. See the Tidal Workload 
Automation Installation Guide for information about how to obtain the software.

To install the Tidal Workload Automation Transporter on Windows:
1. On the machine where you placed the Tidal Workload Automation Base Product installation files, locate the Tidal 

Workload Automation Transporter.msi file in the Transporter folder for your platform and double-click it to start the 
installation program.

2. On the Open File - Security Warning dialog, click Run. 

The Welcome panel displays.

3. Click Next. The Destination Folder panel displays.

4. If a TWA component does not already reside on the machine, specify a directory location to install the application 
files. 

5. Click Next.

The Ready to Install the Program panel displays.

6. Click Install.

The installer displays the installation progress, then the Setup Completed panel displays.

7. Click Finish.

Uninstalling the Transporter
Uninstalling the Transporter is a simple process as the initial installation.

To uninstall the Transporter on Windows:
1. From the Start menu, select Control Panel, then Add or Remove Programs to display the Windows Add or Remove 

Programs dialog.

2. Select the Tidal Workload Automation Transporter <platform> for removal.

3. Click Remove.
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3
Configuring Transporter for Kerberos 
Authentication

This chapter describes how to configure the transporter for kerberos authentication:

 Prerequisites, page 15

 Creating Key tab file for client box (Transporter) user, page 15

Prerequisites
Before installing and using the TWA Transporter, the following requirements need to be fulfilled:

 All Machines required for Kerberos setup should be in the same domain. For example, TWA KERBEROS.COM

 Kerberos Setup for CM requires minimum of four boxes in the same domain with administrator rights.

— Active Directory Box with Domain Controller, for example, named as TWA KDC.

— Client Manager Box, for example, named as TWA APP.

— Master Box, for example, named as TWA MASTER.

— Client Transporter Box, for example, named as TWA CLI.

 Ensure that all the boxes are reachable from each other through the following commands:

ping <hostname> or <IP address>
nslookup <hostname> or <IP address>

Creating Key tab file for client box (Transporter) user
1. Open a command prompt in AD box.

2. Create the Key tab file which is the authorization token for the user (cliuser) of the client box(Transporter).

3. On the command prompt, enter the following command:

ktpass -out <keytab location> -princ <clientbox user>@<realm name> -pass <password> -crypto 
<crypto> -pType KRB5_NT_PRINCIPAL

For example, ktpass -out c:\temp\cliuser.keytab -princ cliuser@TWA KERBEROS.COM -pass control@123 
-crypto AES256-SHA1 -pType KRB5_NT_PRINCIPAL

4. After the key tab file creation, copy the key tab file from the AD box to the client box (Transporter).

5. Ensure that the following artifacts are available in the config folder of transporter, to perform the Kerberos setup for 
the transporter.

spnego.conf file
krb5.ini file
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The contents of the spnego.conf is given below:

com.sun.security.jgss.krb5.initiate {
com.sun.security.auth.module.Krb5LoginModule required
# If the user have the keytab, then they can update the principal, keytab and useKeyTab params
principal=" browseruser@TWA KERBEROS.COM" <client user with realm>
keyTab="c:/temp/appuser.keytab" <location of the key tab file>
useKeyTab=true
storeKey=true 
debug=true 
isInitiator=true;
}; 

The contents of the krb5.ini described below:

[libdefaults]
default_realm = TWA KERBEROS.COM <domain name>
permitted_enctypes = aes128-cts aes256-cts arcfour-hmac-md5 
default_tgs_enctypes = aes128-cts aes256-cts arcfour-hmac-md5 
default_tkt_enctypes = aes128-cts aes256-cts arcfour-hmac-md5 

[realms]
TWA KERBEROS.COM = {
kdc = 172.21.243.238 <IP address of the AD box>
admin_server = 172.21.243.238
default_domain = TWA KERBEROS.COM
}

[domain_realm]
TWA kerberos.com= TWA KERBEROS.COM
.TWA kerberos.com = TWA KERBEROS.COM

[appdefaults]
autologin = true
forwardable = true

6. Edit the transporter.props, and provide the following:

— Location of the krb5.ini file. The customer can provide their own path where the files are located.

security.kerberos.krbpath=C:\\Program Files\\Tidal\\Transporter\\config\\krb5.ini

— Location of the spnego.conf file. The customer can provide their own path where the files are located.

security.kerberos.confpath= C:\\Program Files\\Tidal\\Transporter\\config\\spnego.conf

— Location of the keytab file. The customer can provide their own path where the files are located.

security.kerberos.keytabpath = C:\\Program Files\\Tidal\\Transporter\\config\\cliuser.keytab

— Logging flags

security.kerberos.debug=true

— Timer delay to generate the KTGT for the logged in user on Client box. By default, the time delay is set to 
35999000(9hrs 59 minutes 59 seconds).

security.kerberos.kinittimerdelay= 35999000
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4
Getting Started

This chapter tells you how to start the Transporter and describes its user interface. It also describes security levels, users, 
and authorization. How to create and connect TWA source and destination systems is also covered. 

 Starting the Transporter, page 17

 Understanding the Transporter Interface, page 17

 Securing the Transporter, page 22

 Creating Connection Definitions, page 24

 Creating Kerberos Connection Definitions, page 24

 Connecting TWA Source and Destination Systems, page 25

The Transporter employs default configuration settings which you can modify. See Configuring the TWA Transporter, 
page 27 for how to customize the system and operational configuration options for your environment.

Starting the Transporter 

To start the Transporter:
1. Click Start to display the Windows Start menu.

2. To display the Transporter interface, choose:

All Programs > Tidal Workload Automation > Transporter > Transporter.

Understanding the Transporter Interface
The Transporter main selection screen is divided into two sections with a Source and Destination side. Once connected 
to their respective source and destination, each side displays data objects that can be matched to its corresponding mate 
in the opposite window. A tabbed view of Transport data types is available for selection. Source and Destination object 
lists are merged into a single table view where matching Source and Destination objects are lined up in the same row 
for easy viewing. As a consequence, if the Source and Destination data is very different, there may be gaps in the display. 
For added control over the display, two Preference options are available to control destination display. Refer to 
Preferences Menu, page 19. 

Note: You can adjust the size of these windows by moving the center bar left or right.

The Transporter uses a combination of menu options and a toolbar to access and manage the transporting of data objects 
between source and destination. 

Main Menus
The Transporter contains the following main menus:

 File Menu
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 Preferences Menu

 Search Menu

 Transport Menu

 Actions Menu

 Reports Menu

 Options Menu

 Help Menu

File Menu

The File menu manages the access and reading of file information and the Transporter operation. This menu contains 
the following options:

 Connections – Displays the Connections dialog. This dialog is used to create and modify existing connections to a 
source and destination using connection files. Connections files are created in the user's Transporter home directory. 

For example:

— C:\Documents and Settings\<user>\.transporter

Note: The user information is encrypted in the file, using Triple DES Encryption.

Clicking  on the toolbar is the same as selecting the Connections option.

 Connect – Establishes connections to the source and destination. Once connections are established, the Connect 
option is unavailable; only the Disconnect option is available. 

Clicking  on the toolbar is the same as selecting the Connect option.

 Disconnect – Ends the current session as well as the connection to the source and destination sides. Once the 
connection ends, the Disconnect option is unavailable; only the Connect option is available.

Clicking  on the toolbar is the same as selecting the Disconnect option.

 Configure – Displays the Configuration Options dialog to customize the Transporter for working preference. See 
Configuring the TWA Transporter, page 27 for more information.

Clicking  on the toolbar is the same as selecting the Configure option.

 Read Data – Reads data from both the source and destination for the currently selected object type.

Clicking  on the toolbar is the same as selecting the Read Data option.

 Refresh All – Disconnects and then reconnects to the selected sources.

 Save Map – Displays the Save Map File dialog to save the object mappings that have been selected during the 
current session. The file name you provide is assigned a .map extension. You can avoid repeating the manual 
mapping process for jobs if jobs with the same data objects need to be transported again by saving the object map.

 Save Exclusions - Displays the Save Exclusion to File dialog to save the jobs that need to be excluded from the 
selection file. The file name you provide is assigned a .xpr extension.

 Save Selections (Applies to jobs only) – Displays the Save Selection to File dialog to save the job objects selected 
in the main text field of the source tree. The file name you provide is assigned a .xpr extension. Save job selections 
if you do not want to repeat the same selection process in a future session or you want to schedule the Transporter 
in batch mode. Refer to Running the Transporter in Batch Mode, page 53.
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 Load Selections – Displays the Open Selection File dialog to select and load a selection file that was saved from a 
previous Transporter session.

 Exit – Ends the Transporter session and closes the Transporter application.

Preferences Menu

The Preferences menu allows you to manipulate how data is viewed in the Destination window. This menu contains the 
following options:

 Show Unmatched Destination Items – Displays destination objects that have no matching source only. The default 
is False.

 Show Duplicate Destination Objects – Displays destination objects that have a matching source. The default is 
True.

Note: If both of the above options are set to OFF, no text displays in the Destination window.

 Expand Groups on Read – Expands all job groups in the current view upon read.

 Collapse Groups on Read – Collapses all job groups in the current view upon read.

Search Menu

The Search menu helps you sort through a potentially large number of data objects that may be displayed in the source 
list. This menu contains the following options:

 First – Finds the first match for the criteria entered in the Search Text field. 

Clicking  on the toolbar is the same as selecting the First option.

 Next – Finds the next match for the criteria entered in the Search Text field.  
 
Clicking  on the toolbar is the same as selecting the Next option.

 Filter – Displays the Job Filter dialog that provides various text fields to filter the available jobs/groups that are 
displayed in the source. 

Clicking  on the toolbar is the same as selecting the Filter option.

Note: To search on data against the destination list, right-click on the Destination pane and select Find First or Find Next 
from the following menu options:  
Find First – Finds the first destination match for the criteria specified in the Search text field.  
Find Next – Finds the next destination match for the criteria specified in the Search text field. 

Transport Menu

The Transport menu organizes the tasks directly concerning the transporting of object data. This menu contains the 
following options:

 Mappings – Displays the Scheduler Object Mapping dialog to map the various data objects between the source 
and destination.

 Synchronize – Copies all objects listed in the source listing to the destination. Normally a user would not want all of 
their jobs to be transported at once. The user would select which objects should be transported to the destination.

Depending upon the number of objects in the source, using the synchronize option may require a lengthy amount of 
time to complete.
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 Start Transfer – Begins the transporting process of the selected objects between the source and destination. 

Clicking  on the toolbar is the same as selecting the Start Transfer option. 

Actions Menu

The Actions menu groups together options affecting the operation of the TWA Master and its job schedule. This menu 
contains the following options:

 Pause Scheduler – Pauses the destination TWA Master.

 Create Schedule – Recompiles the destination production schedule for the current or future day.

Reports Menu

The Reports menu provides ready access to the main reports and logs provided by Transporter. Reports are HTML based 
and viewed via the system's default browser. This menu contains the following options:

 Mappings Report – Displays the Scheduler Object Mapping Rules report that details the source objects that are 
currently mapped to corresponding destination objects. Recall that the purpose for mapping source object to 
destination objects is to automate the transporting process. 

 Invalid Mappings – Displays a report of mappings that are no longer valid. Mappings may no longer be valid if the 
object was renamed or deleted in the destination. Therefore, no valid mapping between a source and destination 
object can be established.

 Last Activity Log – Displays the Activity Log report for the last transport operation of the current Transporter 
session.

 Current Session Log – Displays the Activity Log report containing the complete activity log of the current 
Transporter session.

 Past Session Log – Displays the Open Past Activity Log File dialog to select a log file from past Transporter 
sessions. Session logs for the Transporter are saved with transporter-timestamp.sess format where the timestamp 
that the session occurred on is affixed as part of the name. Timestamp has the format: yyyyMMddHHmmssSSS. 

Options Menu

The Options menu is used to export and import objects as files to your file system, making them available for source 
control. See Using the Transporter Export/Import Utility for details. This menu contains the following options:

 Cron Jobs - Has two submenus: Discover Cron and Import Cron. Lets you import the Cron jobs from the UNIX 
boxes to a TWA system.

 Export – Has two submenus: Export Jobs and Export Calendars. Lets you export jobs, job groups, or calendars 
from a source TWA system to the file system.

 Import – Has two submenus: Import Jobs and Import Calendars. Lets you import jobs, job groups, or calendars 
from the file system to a target TWA system.

 Compare – Has two submenus: Compare Jobs and Compare Calendars. Lets you compare previously exported 
jobs, job groups, or calendars in the file system to a target TWA system.

 Delta Import – Has two submenus: Delta Import Jobs and Delta Import Calendars. Lets you import jobs, job 
groups, or calendars from a previously created delta directory to a TWA system.

 Delete – Has two submenus: Delete Jobs and Delete Calendars. Lets you delete jobs, job groups, and calendars 
from a TWA system.
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 Create Delta – Displays a dialog in which you specify the directories of two different versions of exported data, and 
then creating a third directory that contains only the delta files that are different between the two exports.

 Export/Import Mode OR Transport Mode – Let’s you toggle between the main Transporter functionality and the 
export/import functionality.

Help Menu

The Help menu provides information on the version of the Transporter and how to use the application. Selecting this 
option launches your default Web browser and allows you to search for a topic. This menu contains the following options:

 About – Displays the splash screen for the Transporter. The version number of the Transporter is displayed here.

 Contents – Displays the online help system. You can search for a topic from the Help system’s table of contents or 
use the Search or Index features. 

Toolbar/Buttons 
The toolbar provides one-click access to some of the most frequently used features during a Transporter session. The 
buttons are arranged from left-to-right in approximately the same sequence needed during a typical session. The 
buttons duplicate the same options that are available in the main menu but provide more convenient access. The buttons 
and their purpose are:

  Source – Launches the TWA Web Client in your default Web browser for the selected source.

  Destination – Launches the TWA Web Client in your default Web browser for the selected destination.

  Connections – Displays the Connections dialog. This dialog is used to create and modify existing 
connections to source and destination Clients using connection files.

  Connect – Establishes a connection to the items selected in the Source and Destination fields. Once 
the connection is established, the button changes to Disconnect and when clicked ends the connection. Clicking 
this button is the same as selecting the Connect option in the File menu. (A complete refresh of all data objects is 
accomplished during a session by disconnecting and reconnecting.)

  Disconnect – Ends the connection to the items selected in the Source and Destination fields. Once 
the connection ends, the Disconnect option is unavailable. Only the Connect option is available. Clicking the 
Disconnect button on the toolbar is the same as selecting the Disconnect option. (A complete refresh of all data 
objects is accomplished during a session by disconnecting and reconnecting to the source and destination.)

  Read Data – Reads the object data for the definitions from the selected source and destination. Clicking 
the Read Data button is the same as selecting the Read Data option from the File menu.

  Start Transfer – Begins the data transporting process between the selected source and destination. 
(Job transports provide for interactive mapping by transporting individual jobs or job groups.) 

Clicking the Start Transfer button is the same as selecting the Start Transfer option in the Transport menu. 

Note: For Job transports, an individual job or job group can also be transported by dragging and dropping a source job 
or job group to a destination group. Be careful not to drop the job inside the wrong job group in the destination 
inadvertently.)

  Filter – Displays the Job Filter dialog that provides various filter criteria for filtering of jobs/groups that are 
displayed at the source. 

Clicking the Filter button is the same as selecting the Filter option in the Search menu.

  Mappings – Displays the Scheduler Object Mapping dialog where the various objects from the source can 
be associated with corresponding destination objects. 
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Clicking the Mapping button is the same as selecting the Mapping option in the Transport menu.

  Configure – Displays the Configuration Options dialog to customize the Transporter to work according to 
your preference. See Configuring the TWA Transporter, page 27 for more information.

Clicking the Configure button is the same as selecting the Configure option in the File menu.

  Find – Highlights the first source data object that matches the criteria entered in the search text field.

  Next – Highlights the next source match for the criteria entered in the search text field.

Note: To Search on data against the destination list, right-click on the Destination pane and select Find First or Find 
Next from the available menu options available.  
Find First – Finds the first destination match for the criteria specified in the Search text field.  
Find Next – Finds the next destination match for the criteria specified in the Search text field.

 Status Panel – Located at the bottom of the Transporter screen, this panel displays the number of objects selected 
for transport as well as other status messages.

Tabs
The main Transporter selection screen contains a tabbed view of the following Transport Data types: 

 Jobs/Groups – Displays job and job group definitions that can be transported from the source to the destination. 

 Calendars – Displays calendar definitions that can be transported from the source to the destination.

 Business Views – Displays business views that can be transported from the source to the destination.

 Variables – Displays variable definitions that can be transported from the source to the destination.

 Events – Displays the event definitions that can be transported from the source to the destination.

 Resources – Displays resource definitions that can be transported from the source to the destination.

 Actions – Displays action definitions that can be transported from the source to the destination.

 Job Classes – Displays job class definitions that can be transported from the source to the destination.

 Crons - Displays active UNIX agents and its runtime users from the source.

Securing the Transporter
A valid TWA user is an LDAP user with a user record in the Master Database.

When a user logs in to the Client Manager, it sends the username and password to the LDAP server to be authenticated. 
If the user is disabled in LDAP, that user is not authenticated. Once the user is validated, the TESPlugin determines what 
security policies are in effect for the user. 

Given this, there are two levels of security for a Transporter user. First, the Transporter user must be a valid LDAP user 
in order to access Client Manager for data access via the Transporter application. Once the user is authenticated against 
LDAP, the user's access rights are determined given their TWA security configuration and/or rights to access the data 
object.

Additionally, there are two general security functions specific to the Transporter:

 Move Jobs to Production allows a Transporter user to transport objects independent of ownership. 

 Move Own Jobs to Production allows a Transporter user to transport only owned objects. 
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The Transporter user's ability to access data objects for transport is configured given ownership and security policies 
from the TWA Web Client.

Note: A user who has been defined as a Super User has full transport abilities without regard to object ownership nor 
Transporter Security Functions (Move Jobs to Production and Move Own Jobs to Production.

Note: When changing user security policies, The Transporter will not automatically update the list of displayed data 
objects, given new policy updates. You should read again via the Read button anytime data is altered externally from the 
Transporter. Additionally, for Security policy updates, it will take some time for the Client Manager to apply the security 
updates. If after re-reading data, and the data is still not reflective of the user policy updates, Disconnect, Connect and 
then Read. This will force an immediate update.

Defining a User in TWA 
A Transporter user is an interactive user that is either a super user or a non-super user with a specific security policy.

To define a user in TWA:
1. In the TWA Console navigator pane, select Administration>Interactive Users to display the Users pane.

2. Right-click and select Add Interactive User from the context menu, or select and existing user and choose Edit to 
display the User Definition dialog.

3. For a new user definition, enter these values for these fields:

— User Name—Enter a new user name.

— Full Name—Enter a description to help identify this user.

— Domain—Select a Windows domain associated with the user account required for authentication, if necessary.

4. Click the Passwords tab.

5. In the Windows\FTP\Data Mover fields, enter the password and the confirmation password.

6. Click OK to add or save the user record in the TWA database.

Authorizing TWA Users to Work with Transporter Data Objects

To define a Security Policy:
1. In the TWA Console navigator pane, select Administration>Security Policies to display the Security Policies pane, 

listing all defined security policies.

2. Right-click and select Add Security Policy from the context menu, or select an existing policy and choose Edit to 
display the Security Policy Definition dialog.

3. Specify a Security Policy Name.

4. On the Functions tab, double-click the General category and select the functions to be authorized under this policy.

There are two General security functions specific to the Transporter:

Move Jobs to Production—Allows a Transporter user to transport objects independent of ownership. 

Move Own Jobs to Production—Allows a Transporter user to transport only owned objects. 

Super Users have full access to transport objects independent of ownership and security policies.

5. Click OK to close the General dialog.
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6. Click OK to save the policy.

Note: When changing user security policies, The Transporter will not automatically update the list of displayed data 
objects, given new policy updates. You should read again via the Read button anytime data is altered externally from the 
Transporter. Additionally, for Security policy updates, it will take some time for the Client Manager to apply the security 
updates. If after re-reading data, and the data is still not reflective of the user policy updates, Disconnect, Connect and 
then Read. This will force an immediate update.

Creating Connection Definitions
Creating a connection definition refers to defining the connection details for the source and destination TWA systems 
you are transporting data from and to. Data resources are requested given an HTTP (or HTTPS secured connection), 
client connection using HTTP Basic Authentication. Refer to your TWA Installation Guide for more information regarding 
SSL-enabled Client Manager configurations.

Connection details are created via the Connections dialog where connection files containing connection attributes for 
establishing connections are created.

To create a connection:
1. Click Connections to open the Connections dialog.

2. Optionally, click New to populate the fields with default values.

3. Enter these values in the Connections dialog:

— Connection Name—Enter the name for the connection file.

— Server Name—Enter the name of the Tidal Workload Automation Client Manager machine.

— DSP/Plugin Name—Enter the Master instance name. The Master instance name is the TWA DSP or Plugin name 
that is displayed in the Web UI in the Master Status pane.

— Server Port—Enter the listening Web Service port used by the TWA Web Client. The default is 8080 for 
non-secured connections and 8443 for secured connections.

— User and Password—Enter a valid TWA user name and password. 

— Secure HTTP—Select if you want to connect securely through the HTTPS protocol. This option is enabled only 
if the Transporter has been configured for secure connections. For instructions on configuring the Transporter 
for secure HTTP, see Securing the Transporter, page 22.

4. Click Test to validate that the Transporter can connect to the instance.

5. Click Save.

The connections file is created in the user's Transporter Home directory. 

For example: 

— C:\Documents and Settings\<user>\.transporter

Note: The user information is encrypted in the file, using Triple DES Encryption.

Creating Kerberos Connection Definitions
Creating a Kerberos connection definition refers to defining the connection details for the source and destination TWA 
systems you are transporting data from and to. Data resources are requested given an HTTP (or HTTPS secured 
connection) client connection using Kerberos Authentication. Refer to your TWA Installation Guide for more information 
regarding SSL-enabled Client Manager configuration and Kerberos-enabled Client Manager configuration.
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Connection details are created through the Connections dialog where connection files containing connection attributes 
for establishing connections are created.

To create a connection:
1. Click Connections to open the Connections dialog.

2. Optionally, click New to populate the fields with default values.

3. Enter these values in the Connections dialog:

— Kerberos Authentication — Select this option for Kerberos authentication. If selected, the User and Password 
are not displayed.

— Connection Name—Enter the name for the connection file.

— Server Name—Enter the name of the Tidal Workload Automation Client Manager machine.

— DSP/Plugin Name—Enter the Master instance name. The Master instance name is the TWA DSP or Plugin name 
that is displayed in the Web UI in the Master Status pane.

— Server Port—Enter the listening Web Service port used by the TWA Web Client. The default is 8080 for 
non-secured connections and 8443 for secured connections.

— Secure HTTP—Select if you want to connect securely through the HTTPS protocol. This option is enabled only 
if the Transporter has been configured for secure connections. For instructions on configuring the Transporter 
for secure HTTP, see Securing the Transporter, page 22.

4. Click Test to validate that the Transporter can connect to the instance.

5. Click Save.

The connections file is created in the user's Transporter Home directory.

For example: 

C:\Documents and Settings\<user>\.transporter

Note: The user information is encrypted in the file, using Triple DES Encryption.

Connecting TWA Source and Destination Systems
Once you’ve created connections to possible source and destination TWA systems as described in Creating Connection 
Definitions, page 24, the connections appear in the source and destination menus as selectable options and the 
Transporter can connect them.

To establish a connection between TWA source and destination systems:
1. Select a source from the Source list. 

2. Select a destination from the Destination list.

3. Once the source and destination are selected, click the Connect button on the toolbar to connect to the source and 
destination.

Once connected, the Connect button changes to Disconnect and the Connect option in the File main menu is 
unavailable. If the Transporter is connected, then the Source and Destination lists are available.

Note: The list of data objects is displayed automatically if the Read on Connect or New Data Type configuration 
option is selected. See Configuration Options Dialog, page 31 for more information.
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Once connected, you can:

 Configure the Transporter options (see Configuring the TWA Transporter, page 27).

 Read the data and then start selecting the data objects in the source that you want to transport to the destination 
(see Reading Data Objects, page 35).

To select other sources, you must first disconnect from the current connection by clicking the Disconnect button or 
selecting the Disconnect option from the File main menu.
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5
Configuring the TWA Transporter
Overview

There are two types of configuration:

 General Transporter properties—Properties like the Java home directory, logging, file maintenance, security, timeout, 
and performance settings are specified in the transporter.props file. See transporter.props Configuration, page 27.

 How the Transporter application works—Once the Transporter is connected to the selected source and destination, 
you can configure the way the application works. You can modify how the Transporter operates on initial startup and 
the way it works when transporting data objects. The configuration options that are selected are saved for future 
sessions. See Configuring Transporter Options, page 30.

transporter.props Configuration
The transporter.props file contains general Transporter configuration properties. transporter.props, if specified, is located 
under the config directory relative to the Transporter install location. 

For example, if you used the defaults to install the Transporter on a Windows machine where the TWA and Client Manager 
are installed, the properties file can be found here:

C:\Program Files\TIDAL\Transporter\config

The configuration options which are controlled through transporter.props are as follows:

Table 5-1

Transporter Properties Description Default

 JAVA_HOME The location of the Java driver. C:\Program 
Files\Java\jr
e7

 UseUnixId Specifies whether to execute Unix id command to gather user information. The 
Transporter uses context information unique to the login user to encrypt sensitive 
data so no one else can comprise its secrecy. By default, this user information is 
gathered using javax.security.auth.login.LoginContext API. If the runtime 
platform is a Unix system and, for any reason, it does not fully support this API, you 
can set this property to true and the Transporter will gather user information by the 
id command instead.

false

Logging Properties
Valid options are SEVERE, WARNING, FINE, FINER, and FINEST where SEVERE is the least granular (only logging the most 
severe incidents) while FINEST is the most comprehensive.

 TransporterLog Used to control logging of general categories including non-job transports. FINE

 TransporterJobLog Used to control logging of job transport operations. FINE

 TransporterDataLog Used to control logging of data related operations. FINE
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 TransporterUILog Used to control logging of general UI operations. FINE

File Maintenance Properties

 MaxLogFiles Used to control the number of Transporter log files retained. 50

 MaxSessionFiles Used to control the number of Transporter session files retained. 50

Timeout Properties

 CONNECT_TIMEOUT Used to specify a connection timeout in milliseconds; in this example, a time of 20 
sec has been defined.

20000

 READ_TIMEOUT Used to specify a connection read timeout in milliseconds. 20000

Security Property

 Truststore This is used to specify the fully-qualified path of the SSL trust store file to be used 
if you wish to connect Transporter to an SSL enabled Client Manager(s). A 
truststore file is a key database file that contains the public keys for target servers.

For example:

c:\\temp\\mytruststores\\demo-truststore

Note the use of escaped backslashes for windows directories.

If this configuration option is not specified, you will be unable to define a secured 
connection during the process of defining connection files. See Creating 
Connection Definitions, page 24.

There are various tools that allow you to generate keys and certificates and among 
them is the Java Keytool program that comes with the Java JRE installation. All 
keystore entries (key and trusted certificate entries) are accessed via unique 
aliases. An alias is specified when you add an entity to the keystore using the 
-genkey command to generate a key pair (public and private key) or the -import 
command to add a certificate or certificate chain to the list of trusted certificates. 
Subsequent keytool commands must use this same alias to refer to the entity. 

When connecting to multiple Client Manager servers configured for SSL, your trust 
store must contain entries for each Client Manager server you intent to connect to 
via HTTPS. You can use the alias to refer to each of these servers. See your Java 
Keytool documentation for specific details.

None

Table 5-1

Transporter Properties Description Default
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Performance Properties
The following configurations are available in order to provide improved performance for unfiltered job reads. Multiple options 
have been provided for flexibility and the option to be configured may require some tuning based on specific user 
environments. For tuning purpose, it is best to run Transporter in debug mode with an open console so that you can view how 
the reads are performing. 

Note: Only one parameter, READJOBS_PAGINATED, READJOBS_BATCHES, or READJOBS_ALL should be set to “true” at a 
time. Parameter READ_BATCHES applies to READJOBS_PAGINATED or READJOBS_BATCHES. If none of these parameters 
is set, the default configuration is READ_BATCHES=500, READJOBS_BATCHES=true. 

 
READJOBS_PAGINATED

Configures Client Manager to return job data in pages of READ_BATCHES batches. 

For example:

READ_BATCHES=1000 and READJOBS_PAGINATED=true 
 
tells Client Manager to return job data in batches of 1000. This approach reduces 
the overhead on Client Manager as data is sent in smaller batches, as opposed to 
the entire job data in one request. Increasing the READ_BATCHES will reduce the 
number of requests sent to Client Manager, since the jobs are returned in larger 
batches. 

Note: This approach may have less benefit given many jobs (i.e. 50K or more). The 
batching is done at the Client Manager level.

None

 READJOBS_BATCHES Reads jobs given a range of job id’s, where the range is specified via 
READ_BATCHES.

For example, if you have 50K job records with job IDs starting at 1 and ending at 
50,000, and you have set READ_BATCHES=1000 and READJOBS_BATCHES=true, 
requests will be sent to Client Manager to query job records, in ranges as follows, 
until no more records are returned. 
1. jobid >=1 and jobid <=1001 
2. jobid >=1002 and jobid <= 2002 
3. jobid >=2003 and jobid <= 3003 
4. …

Note: This approach appears to be more beneficial when there are many job 
records, for example, 50,000 or more).

None

 READJOBS_ALL This reads all jobs given the first and last job id. The result is that all jobs will be 
read in a single request. This approach is different from the job.getList call in that 
while both return all jobs, this request adds a query condition to the request, which 
seems to produce better performance. However, because all records are returned 
in a single request, Client Manager will need to process all the records for return to 
Transporter. If there are many job records, the overhead on Client Manager may be 
to high.

None

 XPORTER_DEBUG Specify YES to run the Transporter in debug mode. Run the Transporter using the 
transporter.cmd script located in bin.

None

Kerberos Properties

Table 5-1

Transporter Properties Description Default
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Configuring Transporter Options
You use the Configuration Options dialog to configure the Transporter to work according to your personal preference. 
Keep these things in mind when configuring the Transporter:

 Some configuration options can be locked down so that no one without Super User authorization can modify the 
settings. These options have a Restricted check box beside them.

Users without Super User security will not see the Restricted check boxes.

If a configuration option has been restricted, that option is unavailable to other users. These configuration restrictions 
apply only to the selected destination. If another source is selected for the destination, then the same restrictions do 
not apply.

 Transporter configuration options are saved in the user's Transporter Home Directory to a file called user.props. For 
example, a file called user.props will be created in the following directory for Windows Server 2008 R2 Enterprise: 

C:\Users\<user>\.transporter\config\

A user's home directory is different on different platforms. The example provided is specific and intended for 
demonstration only. Your configuration will be different. 
 
Following are examples of user home locations by platform: 
 
Microsoft Windows NT: <root>\WINNT\Profiles\<user> %UserProfile% 
Microsoft Windows 2000, XP and 2003: <root>\Documents and Settings\<user> 
Microsoft Windows Vista and 7: <root>\Users\<user>

security.kerberos.krbpat
h

Specifies the location of the krb5.ini file. The customer can provide their own path 
in which the files are located.

C:\\Progra
m 
Files\\Tidal\
\Transporte
r\\config\\k
rb5.ini

security.kerberos.confp
ath

Specifies the location of the spnego.conf file. The customer can provide their own 
path in which the files are located.

C:\\Progra
m 
Files\\Tidal\
\ 
Transporter 
\\config\\sp
nego.conf

security.kerberos.keytab
path

Specifies the location of the keytab file. The customer can provide their own path 
in which the files are located.

C:\\Progra
m 
Files\\Tidal\
\Client 
Transporter 
\\config\\cli
user.keyab

security.kerberos.debug Logging flags False

security.kerberos.kinitti
merdelay

Specifies the timer delay to generate the KTGT for the logged in user on Client box. 35999000

Table 5-1

Transporter Properties Description Default
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Configuration Options Dialog

To display the Transporter Configuration Options dialog
1. Run the Transporter.

2. Click Configure on the Transporter toolbar or select the Configure option from the File menu.

Transporter displays the Configuration Options dialog. 

The following sections describe the options in the Configuration Options dialog.

General Options Section

 Connect on Startup – Connections started to the most recently selected source and destination are made whenever 
Transporter is started.

 Read on Connect/New Data Type – Once a connection is established between the source and destination, the data 
type used in the last Transporter session is read and displayed. If the data type is changed during the session, it is 
also read.

 Include Duplicates (Replace Allowed) – Displays any duplicate data objects on the Source side in blue. If this option 
is not selected, then objects already existing on the Destination side are not displayed on the Source side (since 
there may be no need to transport them again).

A job group will be displayed if at least one child job within that job group is not a duplicate even if the job group is 
duplicated.

 Log Directory – Specifies where the session log file(s) are written to. 

By Default, session logs are created with .sess extension and saved to the user's Transporter Home directory under 
a subdirectory called sessions. This default location may be changed given this option.

Default location example for Windows Server 2008 R2 Enterprise:

C:\Users\<user>\.transporter\session\transporter-20100506025113898.sess

A user's home directory is different on different platforms. The example provided is specific and intended for 
demonstration only. Your configuration will be different. 
 
Following are examples of user home locations by platform: 
 
Microsoft Windows NT: <root>\WINNT\Profiles\<user> %UserProfile% 
Microsoft Windows 2000, XP and 2003: <root>\Documents and Settings\<user> 
Microsoft Windows Vista and 7: <root>\Users\<user>

Transport Options 

 Display Warnings – Displays a warning message each time a non-critical issue is encountered as data is 
transported. The operator has to acknowledge each warning message as it is displayed to continue the transporting 
operation.

 Annotate – Updates either the Description or Notes (for Jobs) field with the names of the source, the user, and the 
date and time of the transport of data objects.
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Note: If you are transporting data objects, Transporter may not be able to annotate these objects. The Description 
text fields of data objects are limited to 4000 characters and there may not be any room available in the Description 
field to add annotations. Deleting text in the object’s Description field will provide room for annotations. If the 
Transporter cannot annotate the data objects it is transporting, this is noted in the session log. This issue does not 
apply to jobs that are transported when using the Annotate option.

 Disable Copy – Disables each job, event, or resource as it is transported into the destination. This option ensures 
that the object cannot be used in the schedule until the operator manually enables it. This option only applies to jobs, 
events, and resources; other objects do not have this attribute.

Job Transport Options Tab

 Auto Select Dependencies – If a job selected for transporting has any predecessors, all of its predecessors are also 
automatically selected for transporting. This option works in conjunction with the Replace Existing Dependencies 
option.

Note: The Auto Select option may affect system performance when used.

 Replace Existing Dependencies – Selects only a dependency if it does not already exist in the destination.

 Auto Select Parent Group – If a job selected for transporting is a child job, then all of the parent job groups it belongs 
to are also automatically selected for transporting.

 Auto Select Children – If a job selected for transporting is a parent job, then all of its child jobs are also automatically 
selected for transporting.

 Auto Add (no errors, no conflict) – Performs the Job transport operation automatically if no conflicts or errors are 
detected. If a mapping error or conflict occurs, the Job Definition Mapping dialog is displayed to resolve the 
problem interactively.

 Allow Conflicts – Allows a Job transport as long as there are no errors during the transporting operation, even if 
mapping conflicts occur. If a conflict between the source and destination is not resolved, that job may still run 
correctly but may be missing dependencies, variables, or events, etc.

 Effective Date – Enter a date in the text field or click on the down arrow to display a calendar where a date can be 
selected to indicate the earliest date that the transported job can be compiled into the schedule.

Warning: Changing the default Effective Date (current date) from the current date while transporting job groups 
cause severe disruptions in the production schedule. Do not modify the Effective Date option to resolve this issue. 
Instead use one of two methods to transport a job group with a future effective date. Either disable the job group 
and then transport it with the default Effective Date (current date) or select the Disable Copy and No Compile 
options in this dialog before transporting job groups. After the job group transport is complete, enable the job group 
and schedule it as needed.

Override Options Tab 

The Override Options tab sets the default handling of job output.
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 Save Output Option, Override option – Check this box to specify what will happen to the job's output. If job output 
is saved, you can view it from the Output tab of the Job Detail dialog. You can choose from the following options:

— Discard – Does not save the job output. (Default)

— Append – Saves the complete output from each job instance, adding the output to the previous job instance’s 
output.

— Replace – Saves the complete output from each job instance, overwriting the previous job instance’s output.

— Summary Only – Select this option to save the job output in a summary form. This option is useful when jobs 
have long job output and you do not want the entire output file. Not available if the Discard option is selected.

 Override option – Check this box to control how the transport jobs can be scheduled and run.

— Allow unscheduled – Enables the job to be inserted into the production schedule on an as-needed basis. The 
default is that unscheduled instances are allowed. If you do not want the job to run on an ad hoc basis, you can 
clear this option to prevent non-scheduled submissions.

— Allow operator rerun – Allows the operator to rerun a job. The default is allow operator reruns (options 
selected).
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— For UNIX, source user’s profile – Allows you to execute Unix user profiles. This option provides for the execution 
of all variables in a Unix user’s profile. Without this option, Unix user profile variables that are referenced by 
scripts are not being executed, causing errors in TWA .

— Require operator release – Holds the job until an operator releases it. The job will not run until it is released. 
When all the job’s dependencies are met, and it is ready to run, its status is Waiting On Operator. The information 
in the Operator Instructions field (Description tab) can inform the operator of any external requirements that 
need to be met before the job is released.

— Disable carryover – Disables the job carry forward feature that appends the jobs that did not run in the current 
production schedule to the next day's production schedule. Any job from the current production schedule that 
is not in an Active or a Launched status when the next production day starts, will not be carried over to the next 
production day. The default is to enable job carry forward (cleared).

Job Transport Annotation Tab 

When an object is transported, a description of the transport operation is annotated to the description field of the object, 
if Annotate is selected. This option provides for a customizable annotation message to the job description during 
transport. Use the Configuration Options dialog to supply a global annotation message which will apply to all jobs during 
transport.

To override the global setting during interactive job transport, supply a new value in the Annotation tab of the job 
transport. 

The job is transported with the customized annotation included in the job's notes field. In the following example, the 
annotation has been overwritten by appending with xx at the end. 

Also, a description of the transport operation is annotated at the end of the custom annotation.

Job Import Options Tab

 Business Views – Check to import business views with the transport.

Automatic Mapping Options Section

 Dynamically Update Map – Maps the object in the source as soon as a mapping selection is made from the 
destination during job transport.

 Prompt for Map Updates – Each time data objects are selected to resolve conflicts or errors during job transport, 
you are prompted to update the mapping. 

 Do Not Update Map – The paths between objects in the source and destination are manually resolved during job 
transport, but not mapped.

Automatic Compile Options Section

These compiling options are used to control compilation of production schedules at the destination, during job transport. 
When a job is transported, the job update will affect the destination production schedule given the options selected.

 No Compile – The changes are not applied until the next time the schedule is compiled. The changes do not apply 
to the schedule currently running (including the future days already compiled).

 Compile-Repeats Start Now – The changes are applied to the schedule currently running. Any changes that apply 
to the repeating jobs within the current day's schedule take effect when the schedule is recompiled. This is the same 
as selecting the Start today's repeating job(s) now option that is in the Effective Date dialog displayed in the TWA 
Web Client whenever adding a repeating job with an associated calendar date belonging to the current production 
schedule.

 Compile-Skip Repeats – The changes are applied to the schedule currently running.

Instances of repeating jobs are skipped if they would have run prior to the current time.
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6
Reading Data Objects

Once connections to the selected sources and destination are established, you can read the data and then select the 
type of data objects to display and transport. This chapter describes how to read the data, display data types, filter and 
select objects, and save job selections to a file.

 Reading the Data, page 35

 Displaying Objects by Data Type, page 35

 Filtering Data Objects, page 36

 Selecting Specific Data Objects, page 37

 Saving the Job/Job Group Object Selections, page 39

 Loading Selected Data Objects from a File, page 39

 Excluding the Job/Job Group Object Selections, page 39

Reading the Data

To read the data:
1. Connect to the source and destination clients as described in Connecting TWA Source and Destination Systems, 

page 25. 

Note: The list of data objects is displayed automatically if the Read on Connect or New Data Type configuration 
option is selected. See Configuration Options Dialog, page 31 for more information.

2. Click the Read Data button to display a list of data objects based on the currently selected data types. 

The Jobs/Job Groups data type is selected by default once a connection is established for the first time. The last selected 
data type is saved once the current session is closed and the application terminated. This data type will be selected upon 
start of the next session. 

To select a different type is a simple matter of selecting the corresponding tab. The type of data object that is currently 
selected is displayed in the title as well as the status panel of the Main Selections dialog.

Displaying Objects by Data Type
The type of data object displayed is managed using the tabs on the Transport main screen. Select a data type for display 
by selecting the corresponding tab. The data type options are:

 Jobs/Job Groups

 Calendars

 Business Views

 Variables
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 Events

 Resources

 Actions

 Job Classes

 Crons

The list of data objects for each type can be very extensive depending upon the source. If you are working with job data 
objects, the number of jobs listed can be very large. With job objects, it is recommended that you filter out unwanted 
jobs before selecting the jobs to transport. The filter criteria specified in the current session is saved upon application 
termination and available for subsequent sessions. Only Jobs/Job Groups can be filtered.

Filtering Data Objects
Selecting the job data type may list an extensive number of jobs and job groups, making it difficult to navigate to the 
desired jobs and groups for transport. You can use a filter to limit which jobs and job groups to display in the Source field. 

Note: Only Jobs and Job Groups can be filtered.

Job Filter Dialog
The Job Filter dialog is displayed by clicking the Filter button or by selecting the Filter option under the Search main 
menu.

Use this dialog to filter out undesired jobs. The elements included on this dialog are as follows:

 Job Name– Displays all the job instances that match the specified text string. You can use the wildcard characters, 
* (asterisk) or % (percent sign), in all text fields that use text strings. For example, A* will match (display) AB, ABB, 
and ABBB.

 Job ID – Displays all the job instances that match the specified ID string. 

 Group Name – Filters for all job groups and their child jobs matching the criteria specified in this text field. The Show 
Groups option must be selected before you can use this text field. This text field also allows wild card characters.

 Command – Filters for jobs that use a specified command.

 Agent – Filters for all job instances that run jobs on the agent selected from the list. When no agent is selected, all 
agents are assumed. The default is to show all agents.

 Owner – Filters for all job instances that owned by the user or workgroup selected from the list. If left blank, jobs 
belonging to all of the various owners are displayed.

 Calendar – Filters for jobs that use a specific calendars.

 Job Class – Filters for all jobs belonging to the job class selected from the list. If left blank, jobs belonging to all job 
classes are displayed.

 Enabled – Selecting the Yes option filters for all jobs that are enabled. Selecting the No option filters for all jobs that 
are disabled. Leaving this text field blank includes all jobs, whether enabled or not.

 Show Groups – Filters for job groups. Selecting this option ensures that all job groups/jobs are displayed according 
to their parent/child relationships. Leaving this option cleared means that the parent/child relationships of job groups 
are not displayed.
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 Use Server Filtering – Used to limit the number of records returned to Transporter. A query condition that specifies 
the filter criteria is generated on the database server, and has a direct performance benefit, especially for large scale 
databases. 

 Include Dependencies – While using server filtering, select the Include Dependencies option to ensure the set of 
jobs returned includes dependent jobs. 

The filter is only applied to the Source Database. The destination Database is unfiltered.

 Defaults [button] – Clicking this button resets the job filter criteria to the default options. This clears all text fields of 
their criteria though the Show Groups option is selected by default.

After setting the filter criteria for jobs, click the OK button to display only the jobs in the source that meet the 
specified criteria. 

Even after filtering jobs, you might still have more jobs than you want. You can locate a specific job as described in 
Finding a Specific Data Object, page 37. 

The specific jobs that will be worked with must still be selected as described in Selecting Specific Data Objects, 
page 37.

Finding a Specific Data Object
If there is an extensive list of data displayed in the source or destination lists, you may have difficulty finding a specific 
data object. Transporter provides a way for you to search for a specific data object using a text string.

To find a specific data object at the Source:
1. In the Search field next to the Find button, enter a string of text to search for.

2. Click the Find button to display the first data object that matches the specified criteria from the source list.

3. Click the Next button to go to the next data object that matches the search criteria.

Continue clicking the Next button until you arrive at the desired item.

If no data object matches the search criteria, a “Not found.” message is displayed.

To find a specific data object at the Destination:
1. In the Search field next to the Find button, enter a string of text to search for.

2. Select the First menu option from the Search menu to display the first data object that matches the specified criteria 
from the destination list.

3. Select the Next menu option from the Search menu to go to the next data object that matches the search criteria.

4. Continue selection of Next until you arrive at the desired item.

If no data object matches the search criteria, a “Not found.” message displays.

Selecting Specific Data Objects
While you may want to transport all of the objects listed in the source, it is more likely that you need to selectively 
designate which objects will be transported.

The following options are available for making your selections:
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 For all Data Types, select an individual data object by clicking on the check box to the left of the source object to 
display a check mark.

 For job groups, select a job group by selecting not only the job group but also individually selecting its child jobs.

-or-

Right-click on the job group and select the Check Entire Group option from the displayed context menu. You can 
also click on the job group while pressing the Shift and Ctrl keys to select the entire job group simultaneously.

Note: Clicking on a job group selects the job group parent and all child jobs within the job group given Job Transport 
Configuration options, Auto Select Parent Group and Auto Select Children.

Context Menus
Note: The availability of menu options varies depending on the data type selected.

Right-clicking in the Source or Destination fields displays a context menu of selection and display options specific to 
the data type selected. If a keyboard shortcut is available, it is displayed beside the menu option. 

The following options are available in the context menu at the source for the Job type:

 Check All – Selects all of the listed objects, placing a check mark in each check box.

 Uncheck All – Clears the check box of each selected object.

 Check Entire Group (Applies only to the jobs/groups object type.) – Selects the highlighted job group and its child 
jobs.

 Uncheck Entire Group (Applies only to the jobs/groups object type.) – Clears the check box of the selected job 
group.

 Expand All – Expands all job groups in the source and destination, displaying their child jobs.

 Collapse All – Collapses all job groups in the source and destination, hiding their child jobs from view.

 Include Duplicates – Displays all source objects that exist in the destination. A check mark beside the menu option 
means the option is enabled. No check mark beside this menu option means the option is disabled. No check mark 
beside this menu option means that the option is not selected and duplicate objects are not displayed.

The following options are available in the context menu at the Destination for the Job type:

 Expand All – Expands all job groups in the source and destination, displaying their child jobs.

 Collapse All – Collapses all job groups in the source and destination, hiding their child jobs from view.

 Rename – Allows for the renaming the destination object.

 Enable – Enables a destination object. This option applies to Jobs, Events, and Resources.

 Disable – Disables a destination object. This option applies to Jobs, Events, and Resources.

 Find First – Finds the first destination match for the criteria specified in the search text field.

 Find Next – Finds the next destination match for the criteria specified in the search text field.
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Saving the Job/Job Group Object Selections
The process of selecting job objects to transport can be time consuming, depending upon the number of jobs you are 
working with. Creating a selection file will save time and effort when repeating the transporting process in the future. 
However, the primary benefit of preserving your selections, is that you can perform the transporting operation at a later 
time as a scheduled job in TWA.

The selection file saves the names of the source and destination being used, the current configuration option settings, 
and the jobs/job groups that are selected. The information within the selection file can be examined by opening the file 
with a standard text editor program like Notepad. A .xpr extension is added when the selection file is saved for easy 
identification. By specifying the name of the selection file as a command line parameter, you can run the job transporting 
process as a batch job in TWA . See Running the Transporter in Batch Mode, page 53.

To create a selection file:
1. Complete the selection of the job objects between the source and destination.

2. From the File menu, select the Save Selections option to display the Save Selections to File dialog.

3. Name and save the file to the desired directory location. Providing a qualified name for the selection file will be 
helpful when searching for the file in the future.

An Information dialog confirms that the selection file was created successfully.

Loading Selected Data Objects from a File
If a selections file has been saved as described in Saving the Job/Job Group Object Selections, page 39, you can load 
the job/job group data and configuration option settings specified in the file.

To load data objects from a file:
1. From the File menu, select the Load Selections option to display the Open Selection File dialog.

2. Select the desired file to load the corresponding jobs into the Transporter.

Excluding the Job/Job Group Object Selections
If a selections file has been saved as described in Saving the Job/Job Group Object Selections, page 39, you can also 
exclude the job/job groups saved in the selection file.

To exclude the job/job groups in a selection file:
1. Choose the job objects that you want to exclude from the selection file.

2. From the File menu, select the Save Exclusions option to display Save Exclusions to File dialog.

3. Enter the name of the exclusion file and save the file to the desired directory location.

For example, if you are comparing the job/job group objects in the selections file, the job objects saved in the exclusion 
file will be excluded from the comparison result.
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7
Mapping Data Objects

The data objects in the source do not always exist in the destination or perhaps they use different naming conventions. 
These differences can be resolved by matching a data object in the source that does not exist in the destination to a 
different but comparable data object in the destination. This process is called mapping.

This chapter provides an overview of mapping and how to map the object in these sections:

 Overview, page 41

 Scheduler Object Mapping Dialog, page 41

 How to Map Data Objects, page 42

 Saving the Mapping of Data Objects, page 43

Overview
To ensure that the Source objects are transported to the correct Destination objects, Transporter provides a mapping 
mechanism. Mapping data is applied to an object's referenced objects and not to the actual object itself. Mappings 
automate the transporting process as discrepancies between source and destination object references are automatically 
mapped given the mapping rules. For convenience, mapping rules can be saved in a map file and restored later.

The mapping process is done in the Scheduler Object Mapping dialog. In this dialog, a list of the various types of data 
objects is divided into two columns. One column displays the data objects of the source and the other column displays 
the data objects of the destination Master. By comparing the source and destination side-by-side, you can easily spot 
any differences that need to be mapped.

The mapping process involves going down the column of source data objects and ensuring that a match for the 
comparable data object that is missing in the destination is mapped. Once the mapping is completed, the transporting 
process that transports the jobs or other data types from one source to another can start. Mapping can also be done 
dynamically for Job transports during the actual transporting procedure so that a complete map is built over time.

Scheduler Object Mapping Dialog
To display the Scheduler Object Mapping dialog, click the Mappings button on the Transporter toolbar or select the 
Mappings option of the Transport main menu.

The Scheduler Object Mapping dialog displays the following tabs:

 Object Map Filename – The name of the object map file. By default, the file is given the name of the source and 
given a .map extension.

 Connections – This tab displays a list of defined agent connections that exist in the source and provides for a 
mapping of a corresponding destination agent.

 Agent Lists – This tab displays a list of defined agent lists that exist in the source and provides for a mapping of a 
corresponding destination agent list.

 Calendars – This tab displays a list of defined calendars that exist in the source and provides for a mapping of a 
corresponding destination calendar.
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Note: If a selected calendar depends upon a fiscal calendar, the fiscal calendar is also transported with the selected 
calendar.

 Classes – This tab displays a list of defined job classes that exist in the source and provides for a mapping of a 
corresponding destination job class.

 Events – This tab displays a list of defined events that exist in the source and provides for a mapping of a 
corresponding destination event.

 Groups – This tab displays a list of defined job groups that exist in the source and provides for a mapping of a 
corresponding destination group.

 Owners – This tab displays a list of defined users and workgroup owners that exist in the source and provides for a 
mapping of a corresponding destination owner.

 Users – This tab displays a list of defined users that exist in the source and provides for a mapping of a 
corresponding destination user.

 Variables – This tab displays a list of defined variables that exist in the source and provides for a mapping of a 
corresponding destination variable.

 Virtual Resources – This tab displays a list of defined virtual resources that exist in the source and provides for a 
mapping of a corresponding destination virtual resource.

 Custom Resources – This tab displays a list of defined custom resources that exist in the source and provides for a 
mapping of a corresponding destination custom resource.

 Timezones – This tab displays a list of defined timezones that exist in the source and provides for a mapping of a 
corresponding destination timezone.

How to Map Data Objects
Each list that is displayed by clicking one of the buttons listed above is divided into two columns that display the selected 
data object type from the source and destination. If an object type that exists in the source also exists in the destination 
Master, it is displayed in the destination column (unless previously mapped to a different destination object). If there is 
no matching object type on the destination side (and that object has not been mapped), that space is blank.

On the right side of each Destination text field is a combo box that displays a list of available values. Select an object 
from the list to associate with the source data object. Ideally, you would match up each value displayed on the source 
side with a value on the destination side.

However, the jobs or other data that are being transported may not use all of the values that exist in the source. You may 
wish to map only the data object values that you think are needed and leave the rest unmapped.

Note: Mappings apply an object’s referenced objects and not the actual object itself.

The idea behind mapping the data objects is to provide a means to automate transporting of data between the source 
and destination. 

With a map file, it is easy to schedule a batch job in TWA to transport a job or job group between the source and 
destination. Refer to Running the Transporter in Batch Mode, page 53 for information on using Transporter in batch mode.

Default Mapping Option
You can configure a default mapping value for each type of data object. Each list of potential values for a data object type 
in the source starts with a default. This default has no value until it is assigned a destination value.

Specify a value for default by selecting a value from the list on the Destination side. This default value will be used during 
object transporting whenever a corresponding data object is not mapped in the destination.
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Not only can using a default value cut down on possible mapping errors, it can also save you considerable time. For 
example, if you are mapping connection objects and a large number of connections exist in the Source, but only one 
connection is used in the Destination, make the one connection the default. This avoids having to map each individual 
object. However, if the default value is incompatible with the type of data object being mapped, an error will still result. 
For example, if a connection object requires a Unix value and the default value is a Windows value, an error will result. 
In another example, an error would also result if a text string variable is required but the default value is a date calculation 
variable.

Remove Mapping Option
One of the options in the list on the destination side is <<Remove>>. If there is no corresponding destination data object 
to match an existing data object in the Source, you can just delete any reference to the data object when transporting 
objects between Source and Destination. There is no <<Remove>> option on the source side. It only exists on the 
destination side.

The <<Remove>> option allows a source object to be transported to the destination. For example, jobs must have an 
owner and an agent so you cannot remove the owner or agent data objects.

Note: With the <<Remove>> option, data is transported to the destination, while “removing” object references that had 
been mapped to <<Remove>>. Note that an object's required references cannot be removed; mapping an object's 
required reference to <<Remove>> results in an error when trying to transport the object. For example, a job is required 
to have an agent, so if the job's agent is mapped to <<Remove>> you cannot transport the job.

Saving the Mapping of Data Objects
The mapping process can be time consuming depending upon the number of data objects you are working with. If you 
think you might transport the same data types between the same source and destination, you should preserve the 
mapping you have completed for the selected data objects. Creating a mapping file will save time and effort when 
repeating the transporting process in the future. A .map extension is added when the mapping file is saved for easy 
identification.

Creating a Mapping File

To create a mapping file:
1. Complete the mapping of the data objects between the source and destination.

2. From the File menu, select Save Map to display the Save Map File dialog.

3. Name and save the file to the desired directory location. Providing a qualified map file name will be helpful when 
searching for the file in the future.

An Information dialog confirms that the map file was created successfully.

The information within the map file can be examined by opening the file with a standard text editor program like Notepad.

Mapping Reports
Transporter can display two mapping reports that provide details about how data objects were mapped in the current 
session: 

Scheduler Object Mapping Rules—Lists the mapping object type and its corresponding mapping rules that are 
described in a .map file. The report also provides the name of the map file and its source and destination.
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Invalid Mapped Objects—Lists those data objects that it determines to have invalid mapping because the data object 
was deleted or renamed in the destination Master.

To view the Scheduler Object Mapping Rules Report:
 From the Reports menu, select Mapping Report, 

or

 From the Scheduler Object Mapping dialog, click the Report button.

The Scheduler Object Mapping Rules report is displayed in the default browser. See Mapping Report, page 58 for 
an example. 

To view the Invalid Mapped Objects Report:
 From the Reports menu, select Invalid Mappings.

The Invalid Mapped Objects report lists the mapping object type and its corresponding mapping rules that is 
considered invalid. The report also provides the name of the map file and its source and destination Master. The 
Invalid Mapped Objects report is displayed in the default browser. See Invalid Mapping Report, page 58 for an 
example.

Mapping Timezones
TWA can have an associated Timezone. For the Transporter, this means that Timezones can be mapped from source to 
destination. 

A Job can reference a Timezone which affects transporting of Jobs. Timezones are referenced via the Scheduler Object 
Mapping dialog.

The following example shows a source Job (with no Parent) with a referenced Timezone. There is a matching destination 
Timezone (AAA TIMEZONE).

The example below shows a Job (with a Parent, \JOB GOUP) with a referenced Timezone that is inherited from its Parent 
Group. There is a matching Timezone in the destination (TIMEZONE 01).

The following example shows a Job (with a Parent, \JOB GOUP) with a referenced Timezone that is NOT inherited from 
its Parent Group. There is a matching Timezone in the destination (TIMEZONE 01). Note that Timezone inheritance is 
independent of other inherited values (unlike Agent inheritance which is tied to AgentList and Runtime User inheritance).
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8
Transporting Data Objects

This chapter describes how to invoke the transport and then resolve any discrepancies in these topics:

 Overview, page 45

 The Transport Process, page 45

 Resolving Mapping Errors and Conflicts for Jobs, page 47

 Transporting within the Same Database, page 50

Overview
When object differences have been resolved using mapping rules, data objects can be easily transported. For Jobs, if 
some differences between the data objects still occur during the transport process, these differences can be resolved 
on-the-fly via the Interactive Job Definition Mapping dialog.

Warning: Changing the default Effective Date (current date) from the current date while transporting job groups may 
cause severe disruptions in the production schedule. Do not modify the Effective Date option to resolve this issue. 
Instead, use one of two methods to transport a job group with a future effective date. Either disable the job group 
and then transport it with the default Effective Date (current date) or select the Disable Copy and No Compile 
options in the Configuration Options dialog before transporting job groups. After the job group transport is 
complete, enable the job group and schedule it as needed.

The Transport Process
Once an object’s referenced data objects have been optionally mapped between the designated source and destination, 
you can begin the transport process for that object. After selecting the data objects to be transported, you can start the 
transport between the source and destination in one of four ways:

 Click the Start Transfer button on the toolbar.

 Select the Start Transfer option in the Transport main menu.

 For Jobs, drag and drop a single selected data object (or job group) from the Source side to job group on the 
Destination side.

 Press the F9 key

Note: When dragging and dropping job/job groups to the Destination side, be careful that you do place them in the 
intended location. Verify that you are not inadvertently placing the items into the wrong job group.

If there are no problems during the data object transport process, an information dialog displays to notify you that the 
selected number of data objects was successfully transported to the destination.

Note: Re-reading object data by clicking the Read Data button on the toolbar or pressing the F5 key updates the screen 
with the current information.
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Visual Cues
Transporter provides visual clues to provide information at-a-glance about the data objects displayed in the Source and 
Destination.

 The data objects in the Source display in blue to indicate that they exist in the destination (unless duplicate objects 
are filtered out). If the object exists in the destination but is disabled at the source, its text color will be teal.

 Source objects that do not exist in the destination are displayed in black text unless they are disabled, in which case 
their text is displayed in light gray.

 Newly transported objects in the Destination are displayed in blue text to indicate that they were transported during 
the current session. This is reset when object data is re-read.

Warning: If any error messages about connections are displayed while transporting data objects, disconnect from 
the source and destination by clicking the Disconnect button. Resolve the problem and reconnect to continue the 
data transport.

Data types like calendars, variables, events, resources, actions, and job classes are simple to map since they do not have 
many object references. The owner of these type of data objects is usually is the only item that may need to be mapped.

Transporting Job Objects
Jobs are more complicated because of the multiple objects that a job can reference. While there are numerous types of 
data objects referenced in jobs, Transporter is primarily interested in the following data objects that are key to jobs in 
TWA :

 Owner – The owner of the job or job group.

 Agent – The agent that will run the job.

 Job Alias – The alias name for the job.

 Parent – The parent of a child job.

 Job Class – The job class, if any, associated with the job or job group.

 Calendar – The calendar, if any, associated with the job or job group.

 Agent List – The agent list, if any, associated with the job or job group.

 Runtime User – The runtime user, if any, associated with the job or job group.

 Variables – The variables associated with a job.

 Job Events – The job events associated with the jobs.

 Job Dependencies – The job dependencies that exist between the jobs.

 Variable Dependencies – The variable dependencies that exist for the jobs.

 File Dependencies – The file dependencies that exist among the jobs.

 Timezone – The timezone defined among the jobs.

 Virtual Resources – The virtual resources defined among the jobs.

 Custom Resources – The custom resources defined among the jobs.
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Discrepancies between the values of these data objects in each source and destination should be resolved by mapping 
an equivalent value in the destination to the data object in the source. However, if left unmapped, only a subset of these 
values are considered errors and failure to map these will prevent the job transport. Depending on the job type, these 
required fields are Owner, Agent, Agent List, and occasionally Runtime User.

Occasionally, when transporting jobs, a mapping error or conflict may occur. On those occasions, the Interactive Job 
Definition Mapping dialog is displayed to pinpoint and resolve the problem areas.

Resolving Mapping Errors and Conflicts for Jobs
The Interactive Job Definition Mapping dialog provides a means to resolve any differences between the source and 
destination on-the-fly. See Interactive Job Definition Mapping Dialog, page 47 below.

Some data object differences are more critical than others. Mapping differences are divided into two types called Errors 
and Conflicts. Transporter provides visual clues to help the user quickly pinpoint any mapping problems between source 
and destination. Colored text in the Interactive Job Definition Mapping dialog highlights the tab and field where 
mapping differences exist.

Errors
Errors denote more crucial differences between data object. An error occurs when a vital component of a job in the 
source does not exist or is not mapped to an equivalent object in the destination. Errors result from missing values in the 
corresponding data fields that are key to a job. These data fields are the Owner, Agent, Agent List, and Job Alias. You 
can locate the field with the error by looking for the tab with red text. On that tab, a red arrow will point to each field 
containing an error. A job with a mapping error cannot be transported until the error is resolved.

From the destination list for the Error field, select a value in the destination that should be mapped to the source value. 
The number in the Errors field will decrease each time an error is resolved. The job cannot be successfully transported 
to the destination until all errors are resolved. 

Conflicts
Conflicts are the less critical difference between data objects. A conflict occurs when a job object referenced by the 
source does not have a corresponding match in the destination. Unlike errors, these attributes are not critical. You can 
locate the field with the conflict by looking for the tab with the blue text. On that tab, one or more blue arrows will point 
to the field(s) causing the conflict. Conflicts do not prevent the job from being transported, but the conflicts result in a 
loss of data if not resolved (e.g., it may be missing dependencies or associated events, etc.)

From the destination list corresponding to the Conflict field, select a value in the destination that should be mapped to 
the source value. The number in the Conflicts field will decrease each time a conflict is resolved.

Interactive Job Definition Mapping Dialog
The Interactive Job Definition Mapping dialog displays during job transport operations unless the Auto Add 
configuration option was selected. If the Auto Add option is in affect, the Interactive Job Definition Mapping dialog is 
only displayed if a mapping error occurs while transporting the job.
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The title bar of the Interactive Job Definition Mapping dialog displays the current point of progress in the transport 
operation (1 of 1). The following text fields are displayed:

 Job Name – The name of the job being transported.

 Type – Indicates the job type (Job, Job Group, FTP job, etc.)

 Errors – Indicates the number of errors that occurred due to failed mappings between source and destination 
objects. Failed mapping for fields such as Owner, Agent or Agent List and sometimes Runtime Users (depending on 
job type) are considered errors. An error prevents a job from being transported.

 Conflicts – Indicates the number of conflicts that occurred due to failed mappings between source and destination 
objects. Conflicts indicate a job is missing  
non-critical data such as dependencies or events. While the job may still run with conflicts, the missing data may 
prevent the job from running as expected.

Note: You can use the Delete key to clear out non-required fields and if a field has conflicts, the conflict is also cleared.

There are several tabs in the Interactive Job Definition Mapping dialog:

 Key Links – The Key Links tab displays the basic attributes of a job. Three of the fields have required mappings, 
otherwise an error results. These three critical fields are the Owner, Agent, Agent List, and Job Alias. 

Note: A unique job alias is auto-generated by Transporter and does not usually require user intervention.

Any one of these fields in the To Master Value column that do not map to values displayed in the From Master Value 
column displays a red arrow to highlight a mapping error.

When transporting a job with a parent, the Key Links tab displays an Inherited check box next to fields that may be 
inherited from it’s parent job. The fields are the Agent, Calendar, Timezone, Agent List, and Runtime User fields. 
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If the source job inherits attributes from its parent, then the check box will be selected next to the Inherited check 
box. If there is an attribute that is currently not inheriting, you can select the Inherited check box next to the attribute 
you want the transported job to inherit. However, if the job cannot inherit the attribute due to a failure mapping a 
corresponding value from the destination, then an error results preventing transport of the job. You must resolve this 
error to continue with the job transport.

In the previous screenshot, the source job inherits its Agent, Calendar, and Runtime User from its group *AGroup*. 
A parent mapping conflict occurred because the parent *AGroup* does not exist and is not mapped to an alternate 
group at the destination. However, a parent group is not a required attribute of a job, which is why this failed mapping 
is considered a conflict. Because there is no parent selection, the inherited values that cannot be determined are 
blank in the To Master (Destination) side. The non-critical inherited values are displayed as conflicts in blue. The 
Agent field is displayed as an error in red because an agent or agent list is required for jobs. There are several 
options to resolve this error:

— A parent selection can be made as in the following figure. In this case, the selection of group Test Group resolved 
the Agent error because this group has an agent assignment of AGENT MSSQL 01 (MSSql). This group also has 
a calendar and Runtime User.

— A second alternative is to select an agent by clearing the agent Inherited check box. This makes the destination 
Agent list available for selection of an agent value to resolve the agent error. Doing so automatically clears the 
Runtime User check box. You are left with only the Parent and Calendar conflicts. You can resolve these conflicts 
by selecting a parent group and calendar. To select a calendar, clear the Calendar inherited check box. This 
makes the destination Calendar list available for selection of a calendar

Note: If you have Allow Conflicts configured in the configuration option, you will be permitted to transport this job, even 
with conflicts.

If the job is transported with the Parent and Calendar conflict, the resulting job at the destination will not include a 
Parent nor a Calendar reference.

A third option is to make an Agent List selection. You can clear the Agent List inherited check box which enables 
the Agent List combo box selection, and then make a selection. This clears the agent error and allows transport of 
the job depending on resolution of any remaining conflicts.

Setting Inheritance

The following example includes a job that does not inherit from its parent.

When this job is transported, an error in the Agent field occurs because the source Agent AGENT MSSQL 01 is 
non-existent and is not mapped to an alternate destination value. Because an agent or agent list is required for jobs, 
this is presented as an error. This error can be resolved by making an agent or agent list selection.

Since the job includes a parent group, if the parent group has an Agent or Agent List assignment, the error can also 
be resolved by selecting the Agent or Agent List Inherited check box. 

After selecting the Agent Inherited check box, the error is resolved. The corresponding destination group has an 
Agent List assignment rather than an Agent assignment, as does its corresponding source group. In this case, 
selecting the Agent Inherited check box selects the Agent List value that is associated with the destination parent 
group. Note that the Runtime User field is automatically set to inherit and its value selected to match the destination 
parent's assigned Runtime User. This is because Agent/Agent List inheritance also assumes Runtime User 
inheritance. 

Selecting the Agent List Inherited check box has the same result. When this job is transported, it is created under 
the group indicated and its Agent/Agent List value and Runtime User values inherit from this group.

Note: If the destination parent group had no Agent or Agent List assignment, checking the Agent or Agent List Inherited 
check boxes would not resolve the error.
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 Variables – The Variables tab displays the variables associated with the job named in the Job Name field. These 
variables are arranged in two columns, From Master Variable and To Master Variable. At the bottom of the 
Variables tab is a Show Usage button that displays how the variables are used in the job. Unmapped variables are 
displayed as conflicts since jobs do not usually require variables.

Note: You can use the Delete key to clear out non-required fields. This is the same as selecting <<Remove>> from the 
destination list

 Dependencies – The Dependencies tab displays the dependencies associated with the job named in the Job Name 
field. These dependencies are divided into three types of dependencies: job dependencies, variable dependencies 
and file/JES dependencies. Each type of dependency is arranged in two columns, From Master Dependency and 
To Master Variable. Unmapped dependencies are displayed as conflicts since jobs do not usually require 
dependencies.

Note: You can use the Delete key to clear out non required fields. This is the same as selecting <<Remove>> from the 
destination list

Note: In the To Master Agent list, use the <<Remove>> option to remove the corresponding File or JES dependency. 
This option is not used to remove an Agent.

 Job Events – This tab displays the job events associated with the job named in the Job Name field. These job events 
are arranged in two columns, From Master Event and To Master Event.

 Resources – This tab displays the job resources associated with the job named in the Job Name field. These 
resources are arranged in two columns, From Master Resource and To Master Resource.

Note: You can use the Delete key to clear out non-required fields. This is the same as selecting <<Remove>> from the 
destination list.

 Options – This tab allows you to set the default handling of job output.

 Annotation – When an object is transported, a description of the transport operation is annotated to the Description 
field of the object, if Annotate is in effect. This option provides for a customizable annotation message to the job 
description during transport. 

The Interactive Job Definition Mapping dialog displays the following buttons:

 Accept – Accepts the changes you have made, saves the job, and displays the next job to be mapped, if any. When 
there are no more jobs to process, the dialog is closed. If a mapping error is not resolved, the Accept button is 
unavailable and you can only cancel the job and go to the next job for processing. The dialog updates with data for 
each job in process.

 Accept All – Accepts all selected jobs for transport without displaying the mapping dialog for the job. Jobs with 
errors will be skipped. Jobs with only conflicts will be accepted only if Allow Conflicts is enabled. Use this option 
only if you are confident that all items were properly mapped earlier. Selecting the Accept All button displays the 
message”Only jobs without conflicts or errors will be accepted automatically. Proceed?”

 Cancel – Closes the displayed job’s mapping dialog without saving any changes to that job and moves on to the next 
job, if any.

 Cancel All – Closes the Job Mapping dialog and cancels processing for jobs that have not yet been processed 
during the current transport operation. Jobs that were accepted earlier during the session will still be transported. 

Transporting within the Same Database
You can transport jobs and job groups within the same database, but the source and destination job cannot be the same. 
The job or job group must be mapped to a different parent if there is an existing parent or to a new parent if none exists.

Note: Transporting within the same database only applies to Jobs; all other tabs are disabled.
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The transported job is then created under the parent group specified, with the original job undisturbed. For example, 
suppose you have a job group called Sales, which includes jobs relating to sales that were originally created under a 
group called Dev while the jobs are under development. Now, suppose you wish to migrate this job to production. You 
can transport the Sales group, but it must first be mapped to a new group. 

Sample Transport within the Same Database
In the example described above, the following job structure exists where job B depends on job A and job C depends on 
job B:

\DEV\SALES\job A, \DEV\SALES\job B, \DEV\SALES\job C

To transport group \DEV\SALES and its child jobs job A through job C:
1. Create a mapping rule for Group DEV. In this example, DEV is mapped to PROD.

Note: In the drop-down menu for group \DEV, you will not be provided an option to map \DEV to itself.

2. Transport SALES and its child jobs. Notice that its Parent Job is mapped to PROD as per the mapping rule above. 
SALES will be created under parent PROD once transported.

Job A is transported under group \PROD\SALES.

Job B is transported under group \PROD\SALES.

Job B is transported with its job dependency on job \PROD\SALES\Job A.

Job C is transported under group \PROD\SALES and similarly along with its job dependency on job 
\PROD\SALES\Job B.

Because this is the first time that the DEV\SALES group was transported, Transporter creates a new group called 
SALES under the mapped group PROD.

A default annotation is included in the Notes tab that indicates the job was created.

After the initial transport, subsequent transport of group \DEV\SALES results in an update to existing \PROD\SALES.

A default annotation is included in the Job notes that indicates the job was updated.

If \PROD\SALES is transported, there will be an error because PROD had not been mapped. To resolve this, you can 
either create a new mapping rule for group PROD via the Interactive Job Definition Mapping dialog or you can 
interactively select a new group from the drop list. \PROD will not be available for selection.
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9
Running the Transporter in Batch Mode

The Transporter can run from the command line or as a batch job in TWA. The Transporter in command line mode only 
applies to jobs. You can either run using an existing selection file or you can specify parameters so that the Transporter 
can transfer a job or job group between source and destination as a batch job in TWA.

This chapter describes how to use the Transporter command line parameters:

 Using Transporter Command Parameters, page 53

Using Transporter Command Parameters
The following command parameters are required to use the Transporter to batch a selection file, job, or job group in TWA. 
Note that quotes are required for parameters which include white space.

 -i – The name of the selection file that was created by selecting jobs/job groups at an earlier time. If you are using 
a selection file, you do not need the other parameters as these parameters are specified in the selection file (unless 
you wish to override the parameter values).

 -a – If you are copying a single job, specify its job alias. You must also use the -s, -d, and -m parameters with the 
-a parameter. If a job already exists in the destination, it will still be copied unless the -X option is used.

-or-

-g – If you are copying a job group specify the full path with the group name in the following format:

\full path\group name

You must also use the -s, -d, and -m parameters with the -a or -g parameter. If a job group already exists in the 
destination, it will still be copied unless the -X option is used.

 -s – The name of the source. (Required if not using a selection file.)

 -d – The name of the destination. (Required if not using a selection file.) 

 -m – The name of the map file. (Required if not using a selection file.)

In addition, there are other options that can be included in the parameters.

 -D – Disables the jobs that are copied to the destination. The jobs will have to be manually enabled before they can 
be run. 

 -S – Automatically copies all predecessors of the selected jobs as well.

 -A – Annotates the Notes tab of a job/job group definition that the object or job/group was copied from another 
source.

 -X – Excludes duplicates. Does not copy a job or job group already present in the destination.

 -SP – If a job selected for copying is a child job then all of the parent job groups it belongs to are also automatically 
selected for copying.

 -SC – If a job selected for copying is a parent job then all of its child jobs are also automatically selected for copying.
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 -C – Compiler option, valid values are OFF (No Compile), NOW (Compile - Repeats Start Now) and SKIP (Compile 
- Skip Repeats).

 -E – yyyyMMdd where (yyyyMMdd is the date format of the effective date for the compile).

 -I – Ignore conflicts.

Running Batch Jobs with the Transporter
Transporter can be scheduled as a batch job in TWA to copy a job/job group or a saved selection of jobs between a 
source and destination.

To run batch jobs with Transporter:
1. Create a job definition in TWA and complete the header text fields.

2. In the Command field, enter the path to the command mode Transporter executable.

3. In the Command Parameters field, enter the parameters to use when copying the jobs. For example, to copy a job 
with alias 7663 from the fulton destination to the drakken destination:

-s fulton -d drakken -a 7663 -D -S -N OFF -m drak.map

To copy jobs from a selection file named Accont.xpr:

-i Accont.xpr

4. Complete the rest of the job definition as with any other job.

From a Command Line

When scheduling Transporter batch mode to run with the TWA Agent, the agent must logon using a user account with 
access to Transporter. The following is an example of setting up the agent user account for Windows.

The example dialog shows a group called Level 1 Group copied from source database localhost to destination database 
UBIN-RT-01, while ignoring conflicts. Also, since auto selection parameters -S(autoselect deps), -SP(autoselect 
parents), and -SC(autoselect children) have not been specified, The Transporter will apply the user options set for the 
current Transporter user.

When transporting a single job via the -g (fully qualified group name) or -a (job alias) parameter(s), -m (map file 
name), -s (source database) and -d (destination database) are required. The following example also includes -I (allow 
conflicts).
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This example uses a selections file to transport job(s), which contains all information required for transport. When using 
a selections file, no other parameters are required, but may be specified if you would like to override certain values 
specified in the selections file.

Transporter Job Exit Codes
If a Transporter job does not complete successfully, it will have one of the following exit codes. Find the exit code to 
diagnose why the job was not successful.

1 = Invalid source specified.

2 = Invalid destination specified.

3 = Processing parameters failed.

4 = Processing selection file failed.

5 = Invalid selection file.

6 = Invalid mapping file.

7 = Unable to find and select all items.

8 = Unable to find the job or job group.

9 = Notify master option has an invalid value. Valid values are Y or N.

10 = Compiler option has an invalid value. Valid values are OFF, NOW and SKIP.

11 = Invalid effective date used.

12 = Group or Job not specified.
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13 = Insufficient parameters.

14 = Source and destination must be different.

15 = Unable to connect to source and destination.

16 = Invalid selection type in selection file.

17 = No items in selection file to be copied.

18 = Not all jobs were copied.
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10
Transporter Reports and Log Files

Reports are HTML-based and viewed via your system's default browser. This chapter provides sample reports and how 
to obtain logging information:

 Sample Reports, page 58

 Log Files, page 59
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Sample Reports

Session Reporting

Figure 1 Session Report Example

Invalid Mapping Report

Figure 2 Invalid Mapping Report Example

Mapping Report

Figure 3 Mapping Report Example
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Last Activity Report

Figure 4 Last Activity Report Example

Log Files

Session Logs
Session logs are created with a .sess extension and saved to your Transporter home directory under a subdirectory 
called sessions, by default. 

The session log directory is configured via the Configuration Options dialog under General Options>Log Directory.

 Windows example: 

C:\Documents and Settings\<user>\.transporter\session\transporter-20100506025113898.sess
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Note: A user's home directory is different on different platforms. The examples provided are specific to internal Windows 
XP systems and intended for demonstration only. Your configuration will be different.  
Following are examples of user home locations by platform: 
 
Microsoft Windows NT: <root>\WINNT\Profiles\<user> %UserProfile% 
Microsoft Windows 2000, XP and 2003: <root>\Documents and Settings\<user> 
Microsoft Windows Vista and 7: <root>\Users\<user>

Diagnostic Logs
New diagnostics logs are created with a .log extension and saved to your Transporter home directory under a 
subdirectory called logs:

 Windows example: 

C:\Documents and Settings\<user>\.transporter\log\Transporter-20100506093221628.log

Note: Diagnostic logging levels may be controlled via transporter.props. There is no corresponding option for session 
logs, which only contains information about data transport for a given session. See transporter.props Configuration, 
page 27 for further information regarding logging options configurable via transporter.props.

Note: A user's home directory is different on different platforms. The examples provided are specific to internal Windows 
XP systems and intended for demonstration only. Your configuration will be different.  
 
Following are examples of user home locations by platform: 
 
Microsoft Windows NT: <root>\WINNT\Profiles\<user> %UserProfile% 
Microsoft Windows 2000, XP and 2003: <root>\Documents and Settings\<user> 
Microsoft Windows Vista and 7: <root>\Users\<user>
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11
Using the Transporter Export/Import Utility

The Transporter Export/Import utility lets you export and import job and calendar data to and from your file system, 
enabling version control and flexibility in transporting data. The Export/Import feature is an enhancement to the TWA 
Transporter. The Transporter interface has been modified to enable this export/import, and a command line interface is 
also provided. Both usage methods are described in this chapter.

These sections describe the Export/Import utility and how to use it:

 Overview of the Export/Import Utility, page 61

 About Exporting Files, page 63

 About Importing Files, page 66

 About Exporting the Delta Data, page 66

 Using the Export/Import Transporter Interface, page 68

 Using the Export/Import Command Line Interface, page 75

 Log File for Export Operations, page 85

Overview of the Export/Import Utility
The Transporter Export/Import utility lets you export data from TWA in the form of XML files to make it possible to archive 
versions of the data in a version control system. The exported data can be imported to a TWA system at any time, 
removing the need to connect to two different TWA systems (source and destination) to effect a transport of data. 

The Import process provides a way to check for mapping errors before actually doing an import. Import also provides a 
way to compare data on the file system with data on a destination system. These features help in running the transport 
process without errors and verifying that data has been imported correctly or has not changed on the destination system. 
Delta and Import Delta features make it possible to find changes between versions of exported data and then import the 
incremental change alone to a destination system.

With the Transporter Export/Import utility, the TWA Transporter provides flexibly in how you manage transport of TWA 
data from one system to another:

 TWA objects can be exported as XML files. 

 TWA objects can be imported to a TWA system from XML files. 

You can export/import individual jobs, job groups, or calenders and their related artifacts. Or, you can use the Transporter 
to save multiple job, group, or calendar selections to a selection file and export/import multiple objects in one operation. 

For convenience as part of the export/import utility, a delete feature lets you remove unneeded files in the destination 
TWA system. This can be handy if you need to further edit the data after an import operation.

The following graphic presents a general overview of the transporter export/import processes. Note that you can do more 
with this utility, like move data to and from non-TWA systems. This just gives you an idea of how the processes work.
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Key Features
The Export/Import utility provides these key features:

 Export—You can export jobs, job groups, calendars and all their related artifacts. You can also export selection files 
previously created in TWA. All are exported as XML files to your file system. 

 Import—You can import jobs, job groups, calendars, and all of their related artifacts that were exported from another 
system. You can import selection files created in TWA. You can also import the delta between two different versions 
that were exported earlier.

 Delta—You can export two different versions and then create a delta directory that contains only the job and calendar 
artifacts that differ between two previously exported versions. The delta includes TWA objects that are new, 
updated, or deleted in the newer version. You can then import the delta data.

 Compare—You can compare the data on the destination TWA with the source data imported from the file system in 
a Compare Report to see if the artifacts and mappings are the same. 

 Validate—Prior to the actual import, you can validate the import files in a Validate Report to make sure that the 
artifacts and mappings are correct. 

 Delete—You can delete a job, job group, or calendar and the relationships with the related artifacts.

Two interfaces are available to control the object export and import: the command line interface and the Transporter 
graphical user interface. You can use these two interfaces interchangeably. Note that the validate functionality is only 
available using the command line interface.

Export/Import Utility Implementation
The export/import functionality has been added to the Transporter, and all existing Transporter functionality still works 
as documented in the Tidal Workload Automation Transporter User Guide. The new export/import utility is additional 
functionality that has implemented in two ways:

Transporter interface—A new Options menu has been added to the Transporter interface that lets you perform the 
export/import functions. See Using the Export/Import Transporter Interface, page 68 for how to use the Options menu. 
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Command line interface—A set of commands can be used in a command line tool to perform the same export/import 
functions. See Using the Export/Import Command Line Interface, page 75 for how to use the commands.

Logging
The location where the log files are output can be configured using log configuration option provider in the Transporter 
graphical user interface.

The level of logging desired is configured in the transporter.props Transporter configuration file. The logging levels are 
as follows, from least to greater debugging: SEVERE, WARNING, FINE, FINER, and FINEST.

File Formats
Data is exported in XML. As the exported data is in text format, the files can be versioned using a version control system.

Automating the Export/Import Operations
Any Transporter command can be scheduled via TWA for automation purposes and may be used in multiple ways. For 
example:

 The export commands can be automated to run on a daily or weekly basis.

 The delta command can be run to compare to export folders and send an email with delta contents.

Security
No new security roles are required. Users of the Export and Import functionalities should have the same amount of 
permissions as are required to run the Transporter.

The user must make sure that the directory to which data is exported has the appropriate access restrictions to read and 
write files.

About Exporting Files
You can export specific jobs, job groups, or calendars. You can also export multiple jobs and job groups or multiple 
calendars using a selection file that has been previously created in TWA. For each of the jobs and job groups exported, 
all child jobs or job groups are exported recursively. Jobs that depend on the jobs are also exported. 

Specifically, a job/job group export includes these referenced artifacts:

 Job groups

 Job classes

 Events

 Actions

 Resources

 Variables

 Business views

In addition, these relationships are exported:
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 AlertAction

 DependencyUnion

 EmailAction

 EventActionJoin

 EventCalendarJoin

 EventJobClassJoin

 EventJobJoin

 ITOAction

 JESDependency

 JobAction

 JobDependency

 LogAction

 ResourceJobJoin

 ResourceNodeJoin

 ServiceAction

 SNMPAction

 VariableAction

 VariableDependency

For calendars, all specified and related calendars are also exported:

 Calendar groups

 Calendar lists

 Child calendars

 Fiscal calendars

 Included/excluded calendars

Static Artifacts
The names of the static artifacts are also exported so that the target environment can be checked for the presence of 
these artifacts at the time of import. Static artifacts are unchanging base artifacts that are expected to be present in the 
target environment when the job or job group is imported. Static artifacts are not imported.

The names of these static artifacts are exported with jobs/job groups:

 Owner

 User

 Calendar

 AgentList
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 ServiceAgentList

 Node

 Businessunit

 Service

 SystemValue

 AgentListJoin

The following static artifacts are exported with calendars:

 Owner

 User

 AgentList

 NodeList

The Export Workflow

When you export a given set of jobs, job groups, or calendars, the following happens:
1. The Export/Import utility attempts to connect to the source Client Manager. If the connection fails, the utility quits 

operation after logging an error.

2. If the connection to the source Client Manager is successful, then the utility checks if the directory provided for 
export is empty. If not empty, the utility logs an error and quits operation. 

3. If the directory provided for export does not exist, the directory is created. The Export/Import utility requires 
appropriate file system permissions to be able to create the directory.

4. Data is exported in XML format after transforming the raw data from TWA to replace database IDs with their 
corresponding names. 

5. If an error is encountered during the export process, the utility quits processing. The utility does not clean/remove 
data that was already exported at the point of error; this is enables analysis of the error that occurred.

6. Once the data is successfully exported to the file system as XML files, the utility writes a file named export.log to the 
export directory to record summary information about the export. The summary information in the export.log 
includes:

 Type of export (job, calendar, job delta, or calendar delta)

 A list of jobs or job-groups selected for export

 The version of the TWA Master

 The time taken for export

The export output has the following directory structure:
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Note: If any input is not valid, the utility halts processing after logging an appropriate error message.

About Importing Files
The import process allows the repository that was exported to the file system to be imported. The export repository has 
an export.log file that has anchoring information that reveals for what job, job group, or calendar artifacts the original 
export was done. The import process reads the export.log file and imports the information for the artifacts mentioned in 
the export.log file. The import process allows a full import or selecting a subset of a previously done export for import. 
You can also import a delta between two different versions of previously exported data.

The Import Workflow

When you import jobs, job groups, or calendars, the following happens:
1. The import folder is checked for presence of data related to jobs, job groups, or calendars to be imported. If the 

required data is not available, the utility quits processing after logging an error.

2. The import process checks for the presence of all static artifacts in the target environment. They include owners, 
users, agents, agent lists and calendars. If any of these artifacts is not present in the target environment, the import 
process fails with a log message listing the objects absent in the target environment.

3. The utility then creates the given job, job group, or calendar and related artifacts in the destination TWA. The import 
is done by reading data from a previously exported repository. See About Exporting Files, page 63.  

4. Upon successful completion of the import, relationships are created. When creating objects and relationships, 
internal identifiers are used in place of names wherever internal identifiers are required. For example, job id is used 
in place of the job name, calendar id is used in place of the calendar name, and so on. 

Note: In case of encountering any error in this process, the utility halts processing after logging the operation that failed.

The Validate Only Option

The Validate option lets you validate the imported files to make sure that the artifacts and mappings are correct. This 
functionality is implemented using the command line interface -VT option. 

Note: You must use the command line interface to validate an import as described in Validating Jobs, Job Groups, or 
Calendars, page 83.

When jobs, job groups, or calendars are imported with the validate only (-VT) option, no actual import takes place. 
Instead the process only checks if the necessary information referred to by the imported data or mapped for the imported 
data is present in the destination system. 

For jobs and job groups, the utility validates that the following information is present: Owners, Users, Variables, Virtual 
Resources, Custom Resources, Timezones, Connections, Agent Lists, Calendars, Classes, Events, and Groups.

For calendars, the utility validates that the Owners information is present.

If any of the required references are not present in the destination system, the missing references are reported 
cumulatively for all of the import data in consideration. 

About Exporting the Delta Data
The export/import feature lets you create a delta set of objects that have changed between one export and another. This 
enables an incremental export/import which can save time and disk space. 
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The Delta Workflow
A delta contains either job information or calendar information. The delta function should normally be used when 
comparing two versions of exported data stored in a configuration management system. 

Note: The delta process does not produce a friendly diff if it is used to compare exports from a source and a destination 
system because of the mapping differences. Instead, use the -CO import option to compare the source and destination 
during import.

When the command for creating and exporting a delta is invoked, the following happens:
1. Two versions of export directories are checked to ensure that they only have files that can be identified by the utility. 

If there are files in either version that the utility cannot identify, processing stops after logging an error.

2. The directory specified to output the delta to should either be empty or not exist, or else the utility stops processing 
after logging an error. If the output directory does not exist the utility creates it. Therefore, the Export/Import utility 
requires file system permissions to be able to create a directory.

3. The delta process compares each artifact in two versions of the data and outputs the delta information as follows:

 Matching data—If an artifact in the two versions match, this artifact is not included in the delta.

 Updated data—If the artifacts in the <export-directory-V1> and the <export-directory-V1> do not match, the artifact 
from the <export-directory-V2> is included in the delta.

 New data—If an artifact is in the <export-directory-V2>, but is not in the <export-directory-V1>, it is included in the 
delta.

 Deleted data—If an artifact is in the <export-directory-V1> but is not in the <export-directory-V2>, it is marked for 
deletion in the delta.

4. The delta is output as XML. The delta output retains the XML structure of the source or destination artifacts while 
marking them with modifiers indicating whether the artifacts should be created, updated, or deleted. The structure 
of the delta XML output is as follows:

5. If an error is encountered during the delta process, the utility quits processing. The utility does not clean/remove 
data that was already output up to the point of error so that analysis of the error that can occur.

6. Once the delta is successfully done and written to the file system as XML files, the utility writes a file named 
export.log to the output directory to record summary information about the delta. The summary information in the 
delta export.log includes:
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 Type of delta (job or calendar)

 The version of the TWA Master

 The time taken for export

The delta output has the following directory structure:

The “delta” folder contains the delta information between source and destination repositories (or between repository 
version-2 and repository version-1). The source folder contains the entire content of the source repository so that the 
context for the delta information can be maintained.

Note: Some static data is exported for the purpose of providing the context for the exported data. Delta of static data is 
not done.

Using the Export/Import Transporter Interface 
This section describes how to perform export and import operations using the Transporter user interface:

 About the Transporter Export/Import Mode, page 68

 Exporting Jobs, Job Groups, and Calendars, page 69

 Importing Jobs, Job Groups, and Calendars, page 70

 Comparing Jobs, Job Groups, and Calendars, page 71

 Creating a Delta Data Set, page 73

 Importing a Delta Data Set, page 74

 Deleting Jobs, Job Groups, and Calendars, page 74

Alternatively, all of these operations can also be performed using the command line interface as described in Using the 
Export/Import Command Line Interface, page 75.

Note: If you want validate a job/job group or calendar import prior to performing the actual import, use the command line 
interface.

About the Transporter Export/Import Mode
The Transporter user interface typically displays the “transporter mode” user interface that supports transporting TWA 
objects from one active TWA system directly to another active TWA system. The Transporter user interface also provides 
an “export/import mode” which is accessed via the Options menu. This interface provides options to export and import 
TWA objects (jobs, job groups, calendars and their artifacts) between an active TWA system and the file system. 

To use the Export/Import Mode:
1. Click the Options menu to view the export/import functionality:

See these sections for details about how to perform each operation type using the Transporter interface:

— Exporting Jobs, Job Groups, and Calendars, page 69
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— Importing Jobs, Job Groups, and Calendars, page 70

— Comparing Jobs, Job Groups, and Calendars, page 71

— Creating a Delta Data Set, page 73

— Importing a Delta Data Set, page 74

— Deleting Jobs, Job Groups, and Calendars, page 74

Note: The same export/import functionality provided in the Transporter interface is also provided in the Export/Import 
command line interface. You can use the Transporter user interface described in the following sections instead of, or in 
combination with, the command line interface described in Using the Export/Import Command Line Interface, page 75. 

Exporting Jobs, Job Groups, and Calendars
You can export jobs and job groups or calendars and their related artifacts from an active TWA system to your file system. 
This section describes how to export these objects using the Transporter user interface. 

To export jobs/job groups or calendars using the Transporter interface:
1. From the Transporter Options menu, select Export > Export Jobs or Export Calendars. 

Notice that now there is an Export button, and the Destination side of the panel has a Browse button .

2. Choose the Source TWA system from the drop-down list.

3. From the Destination side of the panel, click the Browse button and choose the export directory (or create a new 
directory).

4. Click Connect.

5. Click Read Data.

6. Optionally, you can:

— Click Configure to configure how the TWA objects are exported. For example, you can choose to include or 
exclude duplicates, include parent or child objects, export business views, export indirectly related artifacts, and 
so on.

— Click Filter to filter the list of TWA objects displayed using the standard Transporter filter dialog.

— Enter text in the Search field above the table and click Find to locate a particular object.

7. From the list of Jobs/Groups or Calendars, check the boxes next to the TWA objects that you want to export.

Note: You can right-click and use the menu to help in your selection process.

8. Click Export.

When the export is successful, Transporter displays the Job Export Completed dialog.

9. Click OK.

You can verify that the jobs/groups/calendars and their artifacts are exported by navigating to the specified export 
directory. All TWA objects are exported as XML files. The \static directory contains static artifacts (see Static Artifacts, 
page 64). An export.log text file is also included (see Log File for Export Operations, page 85).
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Importing Jobs, Job Groups, and Calendars
You can import jobs, job groups, or calendars and their related artifacts from an export directory in your file system to an 
active TWA system. You must have already exported the objects to the file system. This section describes how to import 
these objects using the Transporter user interface. 

Note: As with Transporter mode, how the export and import functionality works can be configured using the configuration 
options as described in “Configuring Transporter Options” section of the Tidal Workload Automation Transporter User 
Guide.

To import jobs/job groups or calendars using the Transporter interface:
1. From the Transporter Options menu, select Import > Import Jobs or Import Calendars. 

Notice that now there is an Import button, and the Source side of the panel has a Browse button .

2. From the Source side of the panel, click the Browse button and choose the directory that contains the TWA objects 
you want to import.

3. Choose the Destination TWA system from the drop-down list.

4. Click Connect.

5. Click Read Data.

6. Optionally, you can:

 Click Configure to configure how the TWA objects are imported. For example, you can:

— Choose to include or exclude duplicates, include parent or child objects, import business views, and so on. 

— Check the Import Override option on the Job Import Options tab to force update of the relationships with 
referenced artifacts in the destination during import. Unchecked, the relationships with referenced artifacts are 
not updated during an import and only the job is updated in the destination. This option has the same effect as 
the -O option used in the importjob command.

— Check the Export indirectly related artifacts option on the Job Export Options tab to export indirectly related 
artifacts. Using this option causes the export of additional artifacts that are not directly related to the exported 
jobs.

 Click Filter to filter the list of TWA objects displayed using the standard Transporter filter dialog.

 Click Mappings to define the mappings of the imported TWA objects.

 Enter text in the Search field above the table and click Find to locate a particular object.

7. From the list of Jobs/Groups or Calendars, check the boxes next to the TWA objects that you want to import. 

Note: You can right-click and use the menu to help in your selection process.

8. Click Import.

The Transporter displays the Processing dialog. Any tabs with conflicts are displayed in blue type, and a blue arrow 
indicates the field or mapping that needs resolution as shown in this example: 
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9. If there are mapping or other issues, resolve them in the Processing dialog.

10. Click Accept or Accept All.

When the import is successful, Transporter displays the Job Transport dialog that tells the number of jobs 
successfully copied.

11. Click OK.

12. Click Read Data to see the jobs/groups/calendars in the destination TWA system. 

Comparing Jobs, Job Groups, and Calendars
You can compare the jobs/job groups or calendars and their related artifacts in your export directory with the TWA 
objects in an active TWA system. You must have already exported the TWA objects to the file system. The result of a 
compare operation is a report. This section describes how to compare jobs/job groups or calendars using the 
Transporter user interface. 

To compare jobs/job groups or calendars using the Transporter interface:
1. From the Transporter Options menu, select Compare > Compare Jobs or Compare Calendars. 

Notice that now there is an Compare button, and the Source side of the panel has a Browse button .

2. From the Source side of the panel, click the Browse button and choose the directory that contains the TWA objects 
you want to compare.

3. Choose the Destination TWA system from the drop-down list.

4. Click Connect.

5. Click Read Data.

6. Optionally, you can:

— Click Configure to configure how the TWA objects are to be imported. For example, you can choose to include 
or exclude duplicates, include parent or child objects, import business views, and so on.

Blue type 
identifies 
tabs with 
mapping 
issues

Mappings 
that need 
resolution
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— Click Filter to filter the list of jobs/job groups or calendars displayed using the standard Transporter filter dialog.

— Click Mappings to define the mappings of the jobs/job groups or calendars.

— Enter text in the Search field above the table and click Find to locate a particular job/job group or calendar.

7. From the list of Jobs/Groups or Calendars, check the boxes next to the jobs/job groups or calendars that you want 
to compare.

Note: You can right-click and use the menu to help in your selection process.

8. Click Compare Jobs or Compare Calendars.

When the import is successful, Transporter displays the Job Transport dialog that shows the path and file name of 
the comparison report that was generated.

9. Click OK.

A report file named compareReport.txt is created one of these directories:

Windows: C:\Users\Administrator\.transporter\report\.

UNIX: /root/.transporter/report/

You can view the comparison report with a text editor.

To exclude certain fields during comparison process only for jobs and job groups:
The following main objects available in the transporter.props file, support during the exclusion of certain fields in the 
comparison process:

 [ACTION]

 [BUSINESSVIEW]

 [EVENT]

 [JOB]

 [JOBCLASS]

 [RESOURCE]

 [VARIABLE]

You should enter the relevant field names under respective objects that has to be excluded during comparison process.

Note: You need to take backup of the existing tranporter.props file as the old file will be overridden with the new file. 
You can then change the same settings in the new transporter.props file.

The relevant property fields and value fields can be excluded during the comparison process. The field names of the 
individual objects must be similar to the tag names generated in the exported XML of relevant objects. The tag names 
are not case sensitive. The improper field names (misspelled names) are not excluded during comparison process. You 
can refer the exported XML of the relevant objects to enter the valid field name.

Note: The existing objects must not be edited or deleted to achieve dynamic exclusion of fields during comparison 
process. Only the field names can be added/deleted or edited.

For example, to exclude the field name <tes:command>ipconfig</tes:command>, enter command as tag name under 
[JOB] object. This field will be excluded from the compare report. Similar way, you can enter the corresponding tag 
names for the required fields of the relevant objects.
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To exclude certain job relations during comparison process only for the jobs and jobs groups:
Enter the relevant field names as specified in the following table:

Note: The relevant field names must be maintained strictly to exclude the comparison of relations with jobs specifically 
for dependencies, events, and resources associated with job. Only the mentioned exclusion objects can be excluded.

You can also exclude the actions associated with events. The relevant field name for [EVENTACTIONJOIN] is 
actionname.

Creating a Delta Data Set
Creating a delta data set is the process of choosing two previously exported sets of objects, then creating a third delta 
directory that contains only the differences between the two exports. This section describes how to create a delta 
directory using the Transporter user interface.

To create a delta directory using the Transporter interface:
1. From the Transporter Options menu, select Create Delta. 

The Transporter displays a Create Delta dialog.

2. Enter the requested information: 

Version 1 Browse for an export directory that you previously created. See 
Exporting Jobs, Job Groups, and Calendars, page 69.

Version 2 Browse for an export directory that you previously created. The 
exported objects must be the same object type as the Version 1 
objects.

Delta Directory Browse for or create a new directory to contain the delta files. The delta 
directory must be empty.

3. Click Create Delta.

The Transporter confirms that the delta directory was created.

4. Click OK.

The delta directory has the following directory structure:

Table 11-1

Job Relations Relevant Field Names Actions

[JOBDEPENDENCY] depjobname Exclude comparison of dependent jobs

[FILEDEPENDENCY] filename Exclude comparison of dependent files

[VARIABLEDEPENDENCY] variablename Exclude comparison of dependent 
variables

[JESDEPENDENCY] jobname Exclude comparison of dependent JES

[EVENTJOBJOIN] triggername Exclude comparison of events 
associated with jobs

[RESOURCEJOBJOIN] resourcename Exclude comparison of resources 
associated with jobs

Table 11-1
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The /delta folder contains the delta information between the export repository version-1 and the export repository 
version-2. The /source folder contains the entire content of the source repository so that the context for the delta 
information can be maintained. The export.log file documents the creation date, export type, and TWA version number.

Importing a Delta Data Set
You can import the job/job group or calendar objects from a delta directory that has been previously created to a TWA 
system.

Note: A delta data set might show that an object has to be deleted. However importing such a delta data set does not 
result in deletion of an object in the destination machine. The import process only creates new objects or updates 
existing ones.

To import a delta directory using the Transporter interface:
1. From the Transporter Options menu, select Delta Import > Delta Import Jobs or Delta Import Calendars.

The Transporter displays a Import Delta For Jobs/Calendars dialog.

2. Enter the requested information: 

Destination Machine Select the TWA system into which you want to import the delta objects. 
The TWA system must be active.

Delta Directory Browse for the delta directory that you previously created. See Creating 
a Delta Data Set, page 73.

Delta Map File Optionally, specify a map file that you previously created and saved 
using the Transporter.

3. Click Import Delta.

The Transporter imports the delta data set in the specified delta directory into the Destination Machine.

Deleting Jobs, Job Groups, and Calendars
You can delete jobs, job groups and calendars from a TWA system using the Transporter Export/Import Options menu.

To delete jobs/job groups or calendars using the Transporter interface:
1. From the Transporter Options menu, select Delete > Delete Jobs or Delete Calendars.

Notice that now there is an Delete Jobs/Calendars button.

2. Choose the Source TWA system from the drop-down list.

3. Click Connect.

4. Click Read Data.

5. Optionally, you can:

— Click Filter to filter the list of objects displayed using the standard Transporter filter dialog.

Table 11-2
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— Enter text in the Search field above the table and click Find to locate a particular object.

6. From the list of Jobs/Groups or Calendars, check the boxes next to the objects that you want to delete.

Note: You can right-click and use the menu to help in your selection process.

7. Click Delete Jobs or Delete Calendars.

8. Type yes in the Input dialog to confirm the deletion.

The Transporter confirms that the jobs/job groups or calendars were successfully deleted.

9. Click OK.

Using the Export/Import Command Line Interface
This section describes the general usage of the Export/Import features from the command prompt. 

To run the transporter using the command line interface:
1. Open a command prompt.

2. Navigate to the directory <installroot>\TIDAL\Transporter\bin.

Two Transporter command script files are provided: “transcmdline.bat” (Windows) and “transcmdline.sh” (Linux).

3. Run the Transporter command script with the appropriate command and options.

transcmdline[.sh] -T <command> -<option> <variable> [-<option> <variable>] ...

where: 

Parameter Description

transcmdline Launches the Transporter command script.

-T Identifies this as a Transporter Task command.

<command> Identifies what task/command the command line interface has to 
perform.

[-<option> <variable>]... Specifies the option and its variable value. Some options are 
required. Multiple options can be specified. Variables containing 
special characters or spaces must be surrounded in double quotes. 
Valid options are documented in the following sections. 

For example, on Windows you might use this command to export a group of jobs:

transcmdline -T exportjob -s MySource -g "\My Job Group" -d "C:\Output\Mar19\Job1"

On UNIX, the command name would be transcmdline.sh.

See the Export/Import Command Summary, page 76 below for a list of the export/import commands.

Table 11-3
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Export/Import Command Summary 

exportjob Export a job or job group to an export 
directory.

Exporting Jobs and Job Groups, 
page 78

exportcal Export a job or job group to an export 
directory.

Exporting Calendars, page 79

importjob Import a job or job group to an export 
directory.

Importing Jobs, Job Groups, or Delta 
Data Sets, page 80

Validate the mappings, dependencies, 
etc. in a job, job group prior to import.

Validating Jobs, Job Groups, or 
Calendars, page 83

Compare an export directory with the 
destination TWA system.

Comparing Jobs, Job Groups, or 
Calendars, page 84

importcal Import a job, job group, or delta data set 
to TWA system.

Importing Jobs, Job Groups, or Delta 
Data Sets, page 80

Validate the mappings, dependencies, 
etc. in a job or job group prior to import.

Validating Jobs, Job Groups, or 
Calendars, page 83

Compare an export directory with the 
destination TWA system.

Comparing Jobs, Job Groups, or 
Calendars, page 84

delta Create a delta directory that contains 
only the differences between two export 
versions.

Creating a Delta Data Set, page 80

deletejob Delete a job or job group. Deleting Jobs and Job Groups, page 84

deletecal Delete a calendar. Deleting Calendars, page 85

How to Perform Typical Tasks with the Command Line Interface
This section describes the commands you need to issue to perform the typical export/import tasks. The sections that 
follow describe the commands and their options in detail.

EXPORT - To export jobs/job groups/calendars:
1. Run the exportjob or exportcal command. 

IMPORT - To import jobs/job groups/calendars:
1. Run the importjob or importcal command.

Table 11-4

Command Use to... See...
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DELTA - To create and import the delta between two systems
1. Run the export command for version 1.

2. Run the export command for version 2.

3. Run the delta command for version 1 and version 2.

4. Run the import command for the destination TWA that matches version 1.

COMPARE - To compare exported data with a destination TWA 
1. Run the export command.

2. Run the import command with the -CO option.

VALIDATE - To validate the data to be imported data into a destination TWA 
1. Run the export command.
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2. Run the import command with the -VT option.

DELETE - To delete data from a destination TWA 
1. Run the deletejob or deletecal command.

See these sections for how to use the specific export/import commands in the command line interface:

 Exporting Jobs and Job Groups, page 78

 Exporting Calendars, page 79

 Creating a Delta Data Set, page 80

 Importing Jobs, Job Groups, or Delta Data Sets, page 80

 Importing Calendars, page 82

 Validating Jobs, Job Groups, or Calendars, page 83

 Comparing Jobs, Job Groups, or Calendars, page 84

 Deleting Calendars, page 85

Exporting Jobs and Job Groups
You use the following command and parameters with the Transporter to export a job, job group, or selection file 
containing job data to your file system. 

Syntax: 
$ transcmdline[.sh] -T exportjob [-a <job-alias> | -g <job-group-name> | -i <selection-file>] -s 
<source-connection-name> -d <destination-directory-name>

Options:
 -T exportjob - Indicate that the transcmdline tool is going to export job data to a file rather than work as a 

transporter.‘-T’ stands for Task. (Required)

 -a <job-alias> - Specify the job to be exported.

 -g <job-group-name> - Specify the job group to be exported.

 -i <selection-file> - Use this option to export multiple jobs and job groups saved in a selection file. The 
selection file must already have been created using the Transporter. See “Saving the Job/Job Group Object 
Selections” section on page 39 for information about selection files.
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 -s <source-connection-name> - Specify the file name containing the source system connection details. 
(Required except if using a selection file. See Note below.) 

Note: If you are using a selection file, you do not need to use the "-s" option as the option is already specified in 
the selection file (unless you wish to override the parameter value).

 -d <destination-directory-name> - Specify the name of the directory in which the files containing exported 
data should be placed. (Required)

 -IR - Export indirectly related artifacts. Using this option causes the export of additional artifacts that are not directly 
related to the exported jobs.

At least one of these options must be specified: -a, -g, or -i.

Examples:
Export a job group:

transcmdline[.sh] -T exportjob -s MySource -g "\Delta Import" -d "C:\Output\Mar19\Job1"

Export a selection file:

transcmdline[.sh] -T exportjob -i "C:\Jobsel.xpr" -d "C:\Output\Mar19\Job2"

Note: Child jobs or job groups are recursively fetched by default (as complete data should be present at the time of 
import).

Exporting Calendars
You use the following command and parameters with the Transporter to export a calendar or selection file containing 
calendar data to your file system. 

Syntax: 
$ transcmdline[.sh] -T exportcal [-c <calendar-name> | -i <selection-file>]  -s 
<source-connection-name> -d <destination-directory-name>

Options:
 -T exportcal - Indicate that the transcmdline tool is going to export calendar data to a file rather than work as a 

transporter. ‘-T’ stands for Task. (Required)

 -c <calendar-name> - Specify the calendar name to be exported.

 -i <selection-file> - Use this option to export multiple calendars saved in a selection file. The selection file 
must already have been created using the Transporter. See “Saving the Job/Job Group Object Selections” in the 
Transporter User Guide for information about selection files.

 -s <source-connection-name> - Specify the file name containing the source system connection details. 
(Required except if using a selection file. See Note below.)

 -d <destination-directory-name> - Specify the name of the directory in which the files containing exported 
data should be placed. (Required except if using a selection file. See Note below.)

Note: If you are using a selection file, you do not need to use the "-s" and "-d" options as the options are already 
specified in the selection file (unless you wish to override the parameter values).

At least one of these options must be specified: -c or -i.

Example:
Export a calendar:
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transcmdline[.sh] -T exportcal -s MySource -c "\Daylight Savings" -d "C:\Output\Mar19\Cas1"

Creating a Delta Data Set
You use the following command and parameters with the Transporter to create a delta directory that contains the 
differences between newer and older export files. The delta data set in the delta directory can then be imported as 
described in Importing Jobs, Job Groups, or Delta Data Sets, page 80. 

Syntax: 
$ transcmdline[.sh] -T delta -s <export-directory-V1> -d <export-directory-V2> -o 
<output-directory-name> 

Options:
 -T delta - Indicate that the transcmdline tool is going to create a delta file rather than work as a transporter. ‘-T’ 

stands for Task. (Required)

 -s <export-directory-V2> - Specify the name of the directory that contains files from a newer export operation. 
(Required)

 -d <export-directory-V1> - Specify the name of the directory that contains files from an older export operation. 
(Required)

 -o <output-directory-name> - Specify the name of the output directory in which the result of the delta process 
is to be output. (Required)

Example:
Create and export the delta between newer and older export files:

transcmdline[.sh] -T delta -s "C:\Output\Mar20\Job2" -d "C:\Output\Mar15\Job1" -o 
"C:\Output\Mar19\Job3"

Importing Jobs, Job Groups, or Delta Data Sets
You use the following command and parameters with the Transporter to import jobs or job groups that were previously 
exported. You also use this command to import delta data that was previously created. You can import full data sets or 
specify individual jobs, job groups, or calendars. Before doing any import, you must export the data from the source 
system. 

Note: A delta data set might show that an object has to be deleted. However importing such a delta data set does not 
result in deletion of an object in the destination machine. The import process only creates new objects or updates 
existing ones.

Syntax: 
$ transcmdline[.sh] -T importjob  -s <source-directory-name> -d <destination-connection-name> [-a 
<job-alias> | -g <job-group-name> | -i <selection-file>] -m <map-file>

Options:
 -T importjob - Indicate that the transcmdline tool is going to import job data from a file rather than work as a 

transporter.‘-T’ stands for Task. (Required)

 -s <source-directory-name> - Specify the name of the directory in which the files containing exported data 
reside. (Required except if using a selection file. See Note below.)

 -d <destination-connection-name> - Specify the file name containing the destination system connection 
details. (Required except if using a selection file. See Note below.)
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Note: If you are using a selection file, you do not need to use the "-s" and "-d" options as the options are already 
specified in the selection file (unless you wish to override the parameter values).

 -a <job-alias> - Specify the job to be imported.

 -g <job-group-name> - Specify the job group to be imported.

 -i <selection-file> - Use this option to import multiple jobs and job groups saved in a selection file. The 
selection file must have been created using the Transporter. See “Saving the Job/Job Group Object Selections” 
section on page 39 for information about selection files.

 -ef <exclusion-file> - Use this option to exclude multiple jobs and job groups saved in a selection file during 
import process. The exclusion file must already have been created using the Transporter. See “Excluding the 
Job/Job Group Object Selections” section on page 39 for information about excluding files.

 -m <map-file> - Specify the name of the map file used to resolve static data differences. (Required except when 
using a selection file.) A map file must have been created and saved using the Transporter utility. See the “Mapping 
Data Objects” chapter in the TWA Transporter User Guide.

Additional optional parameters; use where applicable depending on the exported data you are importing:

 -D - Disables the jobs that are copied to the destination. The jobs need to be manually enabled before they can be 
run.

 -S - Automatically copies all predecessors of the selected jobs as well.

 -A - Annotates the Notes tab of a job/job group definition that the object or job/group was copied from another 
source.

 -X - Excludes duplicates. Does not copy a job or job group already present in the destination.

 -SP - If a job selected for copying is a child job then all of the parent job groups it belongs to are also automatically 
selected for copying.

 -SC - If a job selected for copying is a parent job then all of its child jobs are also automatically selected for copying.

 -C - Compiler option. Valid values are as follows:

OFF (No Compile) - The changes are not applied until the next time the schedule is compiled. The changes do 
not apply to the schedule currently running (including the future days already compiled).

NOW (Compile - Repeats Start Now) - The changes are applied to the schedule currently running. Any changes 
that apply to the repeating jobs within the current day's schedule take effect when the schedule is recompiled. This 
is the same as selecting the Start today's repeating job(s) now option that is in the Effective Date dialog displayed 
in the Tidal Workload Automation Web client whenever adding a repeating job with an associated calendar date 
belonging to the current production schedule.

SKIP (Compile - Skip Repeats) - The changes are applied to the schedule currently running. Instances of 
repeating jobs are skipped if they would have run prior to the current time. 

 -E - <yyyyMMdd> where yyyyMMdd is the date format of the effective date for the compile).

 -I - Ignore conflicts. Allows an import despite missing dependencies in the destination. 

 -m - The name of the map file. Required if a selection file was not used when the data was exported. If the source 
data was exported using a selection file, the mapping information is already included in the data set.

 -IB - Use this option to include business views in the import.

 -CD - Use this option to indicate that a delta is being imported.
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 -CO - Use this option to see a “comparison” of the exported files with the destination TWA system instead of 
perform an actual import. A report file named compareReport.txt is created one of these directories:

Windows: C:\Users\Administrator\.transporter\report\

UNIX: /root/.transporter/report/

 -VT - Use this option if only an import “validation” is to be done instead of an actual import.

 -O - Use this option to force update of the relationships with referenced artifacts in the destination during import. 
Without this option, the relationships with referenced artifacts are not updated during a import and only the job is 
updated in the destination. 

Note: The options -CO, -VT, and -CD are mutually exclusive. The options “-a”, “-g”, “-i” are ignored if either of “-CO”, 
“-VT”, “-CD” is used. If the options “-a”, “-g”, “-i” are not used, the entire repository is considered for import.

Examples:
Import all data that was exported to a directory named \Job1:

transcmdline[.sh] -T importjob -s "C:\Output\Mar19\Job1" -d MyDest -m "C:\Import.map"

Import a specific job group named MyJobGroup that was exported to the \Job1 directory:

transcmdline[.sh] -T importjob -s "C:\Output\Mar19\Job1" -g MyJobGroup -d MyDest -m "C:\Import.map"

Importing Calendars
You use the following command and parameters with the Transporter to import calendars that were previously exported. 
Before doing any import, you must export the data from the source system. 

Syntax: 
$ transcmdline[.sh] -T importcal -s <source-directory-name> -d <destination-connection-name> [-c 
<calendar-name> | -i <selection-file>] 

Options:
 -T importcal - Indicate that the transcmdline tool is going to import calendar data to a file rather than work as a 

transporter.‘-T’ stands for Task. (Required)

 -s <source-directory-name> - Specify the name of the directory in which the files containing exported calendar 
data reside. (Required except if using a selection file. See Note below.)

 -d <destination-connection-name> - Specify the file name containing the destination system connection 
details. (Required except if using a selection file. See Note below.)

Note: If you are using a selection file, you do not need to use the "-s" and "-d" options as the options are already 
specified in the selection file (unless you wish to override the parameter values).

 -c <calendar-name> -Specify the calendar name to be imported.

 -i <selection-file> - Specify the file that contains names of multiple Calendars to be imported.

 -m <map-file> - Specify the name of the map file used to resolve static data differences. (Required except when 
using a selection file.) A map file must have been created and saved using the Transporter utility. See the Mapping 
Data Objects.

 -CD - Use this option to indicate that a delta is being imported. 

 -CO - Use this option to see a “comparison” of the export files with the destination TWA system instead of perform 
an actual import. A report file named compareReport.txt is created one of these directories:
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Windows: C:\Users\Administrator\.transporter\report\.

UNIX: /root/.transporter/report/

 -VT - Use this option if only an import “validation” is to be done instead of an actual import. A report file named 
validateReport.txt is created one of these directories:

Windows: C:\Users\Administrator\.transporter\report\

UNIX: /root/.transporter/report/

Note: The options -CO, -VT, and -CD are mutually exclusive. The options “-c”, “-i” are ignored if either of “-CO”, “-VT”, 
“-CD” is used. If the options “-c”, “-i” are not used, the entire repository is considered for import.

Example:
Importing the calendar objects in the Cal1 directory:

transcmdline[.sh] -T importcal -s "C:\Output\Mar19\Cal1" -d MyDest -m "C:\Import.map"

Validating Jobs, Job Groups, or Calendars
You use the following command and parameters with the Transporter to validate a job, job group, calendar import prior 
to performing the actual import. The validation checks for any errors such as mapping and dependency errors. Before 
doing any import validation, you must export the data from the source system. The validate operation generates a report 
file named validateReport.txt in one of these directories:

Windows: C:\Users\Administrator\.transporter\report\

UNIX: /root/.transporter/report/

An empty report indicates that there no errors with this import. If there are errors, you can use Transporter to correct the 
mapping file to resolve any mapping errors. 

Syntax: 
$ transcmdline[.sh] -T [importjob|importcal] -s <source-directory-name> -d 
<destination-connection-name> -m <map-file> -VT

Options:
 -T importjob|importcal - Indicate that the transcmdline tool is going to import job or calendar data from a file 

rather than work as a transporter.‘-T’ stands for Task. (Required)

 -s <source-directory-name> - Specify the name of the directory in which the files containing exported data 
reside. (Required)

 -d <destination-connection-name> - Specify the file name containing the destination system connection 
details. (Required)

 -m <map-file> - Specify the name of the map file used to resolve static data differences. (Required except when 
using a selection file.) A map file must have been created and saved using the Transporter utility. See the “Mapping 
Data Objects” chapter in the TWA Transporter User Guide.

 -VT - Use this option if only an import “validation” is to be done instead of an actual import.

Example:
Validating the data that was exported to a directory named \Job1:

transcmdline[.sh] -T importjob -s "C:\Output\Mar19\Job1" -d MyDest -m "C:\Import.map" -VT
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Comparing Jobs, Job Groups, or Calendars
You use the following command and parameters with the Transporter to compare an exported data set with the data in 
a destination TWA system. Before doing any comparison, you must export the data from the source system. The compare 
operation generates a report file named compareReport.txt in one of these directories:

Windows: C:\Users\Administrator\.transporter\report\

UNIX: /root/.transporter/report/

Syntax: 
$ transcmdline[.sh] -T [importjob|importcal] -s <source-directory-name> -d 
<destination-connection-name> -m <map-file> -CO

Options:
 -T importjob|importcal - Indicate that the transcmdline tool is going to import job or calendar data from a file 

rather than work as a transporter.‘-T’ stands for Task. (Required)

 -s <source-directory-name> - Specify the name of the directory in which the files containing exported data 
reside. (Required)

 -d <destination-connection-name> - Specify the file name containing the destination system connection 
details. (Required)

 -m <map-file> - Specify the name of the map file used to resolve static data differences. A map file must have 
been created and saved using the Transporter utility. See the “Mapping Data Objects” chapter in the TWA 
Transporter User Guide.

 -CO - Use this option to see a “comparison” of the export files with the destination TWA system instead of perform 
an actual import. A report file named compareReport.txt is created one of these directories:

Windows: C:\Users\Administrator\.transporter\report\.

UNIX: /root/.transporter/report/

Example:
Compare import files in the \Job1 directory with the destination TWA and generate a compare report:

transcmdline[.sh] -T importjob -s "C:\Output\Mar19\Job1" -d MyDest -m "C:\Import.map" -CO

Note: To specify the name of the multiple job or job groups that need to be excluded from the selection file, use - ef 
<exclusion-file>. For example, if you are comparing the job/job groups in the selection file, the jobs saved in the exclusion 
file will be excluded from the comparison result.

Deleting Jobs and Job Groups
When you delete a job or job group, the utility only deletes jobs and direct relationships between jobs and related objects 
but does not delete the related objects themselves.

Note: Be sure to create a backup of the database before invoking the command to delete a job or job group. 

You use the following command and parameters with the Transporter to delete a job or job group from a destination 
system. 

Syntax: 
$ transcmdline[.sh] -T deletejob  [-a <job-alias> | -g <job-group-name> ] -d 
<destination-connection-name> 
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Options:
 -T deletejob - Indicate that the transcmdline tool is going to delete job data rather than work as a transporter.‘-T’ 

stands for Task. (Required)

 -d <destination-connection-name> - Specify the file name containing the destination system connection 
details. (Required)

 -a <job-alias> - Specify the job to be deleted.

 -g <job-group-name> - Specify the job group to be deleted.

 -f - Use this option to avoid a prompt to confirm the delete.

At least one of these options must be specified: -a or -g.

Examples:
Deleting a job group:

transcmdline[.sh] -T deletejob -d MyDest -a "\My Old Job" -f

Deleting Calendars
When you delete a calendar, the calendar and its relationship with child and condition calendars are removed. When the 
command to delete a calendar is invoked, the utility only deletes calendars if the calendars are not associated with any 
other entity.

Note: Be sure to create a backup of the database before invoking the command to delete a calendar. 

You use the following command and parameters with the Transporter to delete a calendar from a destination system. 

Syntax: 
$ transcmdline[.sh] -T deletecal  -d <destination-connection-name> -c <calendar-name>

Options:
 -T deletecal - Indicate that the transcmdline tool is going to delete calendar data rather than work as a 

transporter.‘-T’ stands for Task. (Required)

 -d <destination-connection-name> - Specify the file name containing the destination system connection 
details. (Required)

 -c <calendar-name> - Specify the calendar to be deleted. (Required)

 -f - Use this option to avoid a prompt to confirm the delete.

Examples:
Deleting a calendar:

transcmdline[.sh] -T deletecal -d MyDest -c "\My Alarm Calendar" -f

Log File for Export Operations
Data is written to the export.log file and saved in the export directory when the data is successfully exported to the file 
system as XML files. If an export.log file is not present in the export directory, it indicates that the export is not complete 
or has failed. 
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The export.log file contains a summary information regarding the exported data which includes: 

 Type of export (job, calendar, job delta, or calendar delta)

 A list of jobs or job-groups selected for export

 The version of the TWA Master

 The time taken for export

The format of the export.log file is explained below. Lines that start with a # are comments that explain the following 
statement:

#Type of export indicates whether this is a job export, a calendar export, or a delta
EXPORT_TYPE=Job|calendar|job delta|calendar delta
#If jobs are exported then the comma separated list of jobs input to the export process that resulted 
in the creation of the export repository
INPUT_JOBS=[,]
#If jobs are exported then the comma separated list of jobs input to the export process that resulted 
in the creation of the export repository
INPUT_CALENDARS=[,] 
TIME_TAKEN_FOR_EXPORT=14 seconds 
#The version number indicates that data was exported from a certain version of TES
TES_VERSION=6.1.0.554
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12
Importing/Exporting the Cron Jobs

This chapter explains you about the import of the Cron jobs into TWA and export of the formatted Cron data into the file 
system in CSV format.

 Importing the Cron Jobs

 Exporting the Cron Jobs

Importing the Cron Jobs
TWA users having the legacy Cron jobs that are run on the UNIX boxes, need to import the Cron jobs to the TWA system. 
This section consists of the processes that need to be followed for importing the Cron jobs to the TWA system.

 Discovering the Cron Jobs

 Converting the Cron Expression into the TWA Format

 Creating the Missing Calendars

 Validating and Importing the Cron Jobs

Discovering the Cron Jobs
The legacy Cron jobs that are run on the UNIX boxes are discovered from the configured agents.

To discover the Cron jobs using the Transporter interface:

1. From the Transporter Options menu, choose Cron Jobs > Discover Cron.

2. If the connections are available, choose the Client Manager (CM) to which the Cron jobs are to be imported, from 
the Source drop-down list.

If the connections are not available, you need to create a new connection to the TWA system. For more information 
on creating connections, see “Creating Connection Definitions” section on page 24.

3. To establish the connection to the selected CM, click Connect.

4. Click Read Data.

You can view the list of all the active UNIX agents and its runtime users in the summary screen.

5. Optionally, you can:

 Click Configure to define specific job properties. The Configuration Options dialog box appears.
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The following sections describe the options in the Configuration Options dialog box:

Transport Options 
— Annotate – Updates either the Description or Notes (for Jobs) field with the names of the source, the user, and 

the date and time of the import of data objects.

— Disable Copy – Disables each job as it is imported into the destination. This option ensures that the object 
cannot be used in the schedule until the operator manually enables it. This option only applies to jobs and other 
objects do not have this attribute.

Override Options Tab 
The Override Options tab sets the default handling of job output.

 Save Output Option, Override option – Check this box to specify what will happen to the job's output. You can 
choose from the following options:

— Discard – Does not save the job output. (Default)

— Append – Saves the complete output from each job instance, adding the output to the previous job instance’s 
output.

— Replace – Saves the complete output from each job instance, overwriting the previous job instance’s output.

— Summary Only – Select this option to save the job output in a summary form. This option is useful when jobs 
have long job output and you do not want the entire output file. Not available if the Discard option is selected.

 Override option – Check this box to control how the import jobs can be scheduled and run.

— Allow unscheduled – Enables the job to be inserted into the production schedule on an as-needed basis. The 
default is that unscheduled instances are allowed. If you do not want the job to run on an ad hoc basis, you can 
clear this option to prevent non-scheduled submissions.

— Allow operator rerun – Allows the operator to rerun a job. The default is allow operator reruns (options 
selected).
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— For UNIX, source user’s profile – Allows you to execute Unix user profiles. This option provides for the execution 
of all variables in a Unix user’s profile. Without this option, Unix user profile variables that are referenced by 
scripts are not being executed, causing errors in TWA.

— Require operator release – Holds the job until an operator releases it. The job will not run until it is released. 
When all the job’s dependencies are met, and it is ready to run, its status is Waiting On Operator. The information 
in the Operator Instructions field (Description tab) can inform the operator of any external requirements that 
need to be met before the job is released.

— Disable carryover – Disables the job carry forward feature that appends the jobs that did not run in the current 
production schedule to the next day's production schedule. Any job from the current production schedule that 
is not in an Active or a Launched status when the next production day starts, will not be carried over to the next 
production day. The default is to enable job carry forward (cleared).

Cron Import Tab
— Effective Date - Enter a date in the text field or click on the down arrow to display a calendar where a date can 

be selected to indicate the earliest date that the Cron import can be compiled into the schedule.

Automatic Compile Options
These compiling options are used to control compilation of production schedules at the destination, during job import. 
When a job is imported, the job update will affect the destination production schedule given the options selected.

— No Compile – The changes are not applied until the next time the schedule is compiled. The changes do not 
apply to the schedule currently running (including the future days already compiled).

— Compile-Repeats Start Now – The changes are applied to the schedule currently running. Any changes that 
apply to the repeating jobs within the current day's schedule take effect when the schedule is recompiled. This 
is the same as selecting the Start today's repeating job(s) now option that is in the Effective Date dialog 
displayed in the TWA Web Client whenever adding a repeating job with an associated calendar date belonging 
to the current production schedule.

— Compile-Skip Repeats – The changes are applied to the schedule currently running. Instances of repeating jobs 
are skipped if they would have run prior to the current time.

 Click Filter to filter the list of displayed UNIX agents. The Agent Filter dialog box appears. The elements included on 
this dialog are as follows:

— Agent – Enter the name of the agent. When no agent is entered, all agents are assumed. The default is to show 
all agents.

— Machine – Enter the name of the machine.

— Use Server Filtering – Used to limit the number of records returned to Transporter. A query condition that 
specifies the filter criteria is generated on the database server, and has a direct performance benefit, especially 
for large scale databases. This check box is enabled by default.

— Defaults – Clicking this button resets the agent filter criteria to the default options. This clears all text fields of 
their criteria.

After setting the filter criteria for agents, click the OK button to display only the agents in the source that meet the 
specified criteria.

6. To do a Cron discovery with different user, choose the runtime user from the Runtime User drop-down list.

Note: If the agent has default runtime user, the runtime user will be displayed in the Runtime User column, or it will 
be blank.

To apply the selected runtime user for all the UNIX agents, click Apply. You can override the applied runtime user of 
the selected agent. You can click the Clear button to default the runtime user.
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7. (Optional). Enter the required Cron match pattern to filter the Cron expressions based on the match pattern and click 
Apply.

You can override the applied match pattern of the selected agent. You can click the Clear button to clear the match 
pattern.

8. Check the boxes adjacent to the UNIX nodes to select one or more UNIX Agents and Runtime users.

9. Click Discover Cron to run the Cron discovery process. The following fields are displayed:

— Unix Node - The UNIX agent of the Cron job.

— Cron User - The owner of the Cron job.

— Cron Type - The type of the Cron job includes User or System.

— Working Directory - The home directory of the user. This home directory will be mapped to the working 
directory of the job.

— Cron Expression - The expression of the Cron job.

The user with root privilege, will discover all the Cron expressions for all the users who have Cron. For the user who does 
not have the root privilege, the Cron expressions particular to that user, are displayed.

Note: The following color denote the specific jobs:

— Red - Denotes that the particular agent is invalid during the discovery process and will be disabled.

Converting the Cron Expression into the TWA Format
After the Cron jobs are discovered, all the Cron expressions need to be converted into the TWA format.

1. Check the boxes next to the UNIX nodes that you want to import.

2. Click Begin Conversion.

The Cron expressions are converted into the TWA format and the converted data are displayed which includes the 
following fields:

 Unix Node - The UNIX agent of the Cron job.

 Cron User - The owner of the Cron job.

 Runtime User - The Cron User is same as the runtime user. The user can change the runtime user.

 Cron Type - The type of the Cron job includes User or System.

 Cron Expression - The expression of the Cron job.

 TWA Calendar Exist - The existence of the TWA calendar displaying ‘Y’ or ‘N’.

 Mapped TWA Calendar - The name of the TWA calendar which is mapped to the Cron expression.
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Table 1

Table 2

Month
Days

Month Weeks Mapped Calendar Mapping Calendar Flow Creation Flow

* * * Daily, Weekly, 
Monthly with Days, 
Monthly with Weeks

 If Daily calendar is not 
Identified, it checks for 
Weekly Calendar.

 If Weekly calendar is not 
identified, it checks for 
Monthly with Days 
calendar.

 If Monthly with days 
calendar is not identified, 
it checks for Monthly with 
Weeks calendar.

If no calendars are mapped 
while creating the calendar 
using the Missing Calender 
options, the Daily calendar 
gets created.

* * Specific 
Week

Daily, Weekly, 
Monthly with Weeks

 If Daily calendar is not 
identified, it checks for 
Weekly calendar.

 If Weekly calendar is not 
identified, it checks for 
Monthly with Weeks 
calendar.

If no calendars are mapped 
while creating the calendar 
using the Missing Calender 
options, the Daily calendar 
gets created.

Specific 
Day

Specific 
Month

* Monthly with Days NA If no calendars are mapped 
while creating the calendar 
using the Missing Calender 
options, the Monthly with 
days calendar gets created.

Specific 
Day

* * Monthly with Days NA If no calendars are mapped 
while creating the calendar 
using the Missing Calender 
options, the Monthly with 
days calendar gets created.

* Specific 
Month

* Monthly with Weeks, 
Monthly with Days

If Monthly with Weeks 
calendar is not identified, it 
checks for Monthly with days.

If no calendars are mapped 
while creating the calendar 
using the Missing Calender 
options, the Monthly with 
Weeks calendar gets 
created.

* Specific 
Month

Specific 
Week

Monthly with Weeks NA If no calendars are mapped 
while creating the calendar 
using the Missing Calender 
options, the Monthly with 
weeks calendar gets 
created.

Specific 
Day

Specific 
Month

Specific 
Week

Cannot map any 
calendar

NA Can map only the existing 
calendar.

Specific 
Day

* Specific 
Week

Cannot map any 
calendar

NA Can map only the existing 
calendar.

Cron Expression Mapping or Creation in TWA 
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 Cron Calendar Description - The description of the Cron calendar.

 Job Name - The name you choose for your job.

 Job Class - The class of the job.

 Job Group - The group of the job.

 Job Owner - The user who owns the job in TWA.

 Working Directory - The home directory of the user. This home directory will be mapped to the working directory 
of the job. This field is editable.

 Job Repeat - Number of times the job repeats.

 Job Repeat Interval - The interval between the completion of the previous job run and the beginning of the next job 
run.

 Job Start Time - The time of the job when it is active.

 Remarks - The information about the status of the job and error messages.

If the Cron expression has a matching TWA calendar, the TWA Calendar Exist column displays ‘Y’. Otherwise, ‘N’ is 
displayed next to the corresponding Cron expression.

Note: The following colors denote the specific jobs:

— Red - Denotes the jobs which have irregular job intervals and invalid Cron expressions. These jobs are disabled.

— Yellow - Denotes that the calendar creation for this expression from this tool is not supported. You need to create 
the calendar manually in TWA and map it. These jobs are enabled.

— Blue - Denotes the selected rows throughout the job conversion process.

Creating the Missing Calendars
For the Cron expressions that do not map to the TWA calendar, you need to create a new calendar or map to the existing 
calendar.

1. Choose the individual job owner of the selected Cron expression from the Job Owner drop-down list, or choose the 
job owner at the global header and click Apply. 

2. Optionally, you can:

 Choose the individual job group of the selected Cron expression from the Job Group drop-down list, or choose the 
job group at the global header. 

 Choose the individual job class of the selected Cron expression from the Job Class drop-down list, or choose the 
job class at the global header.

 Click Apply.

3. To clear the selected values, click Clear.

4. Click Create Missing Calendar.

The Calendar Mapping dialog box appears displaying the Cron Expression, Discovered Calendar, TWA Calendar, 
Calendar Name, and TWA Status. 

5. Enter the name of the calendar in the Calendar Name column. 
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From the TWA Calendar column, you can choose ‘New’ to create a new calendar, or choose an existing calendar to map 
the Cron job to the existing calendar.

6. Check the boxes adjacent to the Cron expression.

7. Click Create TWA Calendar.

A success message appears when the new TWA calendar is created in the Calendar Status column. 

Note: You can view the calendar and forecast details at any time from Definitions > Calendars in the TWA Web Client.

8. Click Close.

The parent page is updated and the TWA Calendar Exist column displays ‘Y’ to the corresponding Cron expression. The 
Mapped TWA Calendar column is updated with the created calendar name.

Validating and Importing the Cron Jobs
1. To validate the Cron Jobs before the actual import is done, click Validate Job. 

You can view the validation status in the Remarks column. 

2. To import the jobs that are validated successfully, click Import Job.

3. To re-validate the jobs, click Re-validate Job and then import the jobs.

The Cron jobs are imported successfully and saved in the TWA master. 

You can view the list of complete Cron expressions using the Back button. The successfully imported jobs are disabled 
in the jobs list and shown in green color. You can continue to import the unconverted Cron expressions.

Exporting the Cron Jobs
After converting the Cron data into TWA format, the formatted data are displayed. You can export the TWA formatted 
data to your file system in CSV format. The exported formatted data consists of the following columns:

 Unix Node

 Runtime User

 Cron Type

 Cron Expression

 Mapped TWA Calendar

 Cron Calendar Description

 Job Name

 Job Class

 Job Group

 Job Owner

 Working Directory

 Remarks
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To export the Cron data using the Transporter interface:

1. From the Destination side of the panel, click the Browse button and choose a location to export the files in your file 
system.

2. Click Export to File.

The formatted Cron data are exported to the specific location in your file system successfully.

Importing the Cron Data
You can import the raw or formatted Cron data from your file system to TWA. 

1. From the Transporter Options menu, choose Cron Jobs > Cron Import. You can choose Formatted Cron or Raw 
Cron.

2. From the Source side of the panel, click the Browse button and choose the directory that contains the Cron data you 
want to import.

3. Choose the destination TWA system from the Destination drop-down list.

4. Click Connect.

5. Click Read Data.

When the formatted Cron data is loaded/read successfully, Transporter displays all the Cron jobs.

For the raw Cron data, the Cron Import dialog box appears:

— Unix Node - The UNIX agent of the Cron job.

— Runtime User - The Cron User is same as the runtime user. The user can change the runtime user.

— Working Directory - The home directory of the user. This home directory will be mapped to the working 
directory of the job. This field is editable.

Click Import to import the raw Cron data. The raw Cron data is imported successfully.

The Remarks column provides the status of the invalid Cron jobs. You can correct the invalid data or edit the values by 
exporting the data into a CSV file and importing the data back to the Transporter.
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